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I open Existing Subimissi ] Welcome to eSubmitter! An FDA Electronic Submissions Software Initiative

I g eSubmitter Quick Guide... ]

Overview: This software application enables electronic submission of regulatory information to FDA in an effort to automate the submission process. It contains a number of data capturing tools and helpful dialog boxes to reduce redundant responses,
and fo allow FDA to capture data in a more useful. structured format. These benefits enable Centers within the FDA to improve our review process and reduce lengthy review times.

Getting Started: To familiarize yourself with the eSubmitter application, see the "Getting Started" section of the "eSubmitter Quick Guide", which provides layout information as well as tips for navigating the intro screen. In addition, the "eSubmitter

Quick Guide" also provides information on creating a new on through to the n packaging process. The "eSubmitter Quick Guide" can be launched from the corresponding menu option on the lefi-hand side of this intro screen.
l Eﬁ Exit Application ] Contact Us: Please email any questions or comments concerning this software application to the eSubmitter team at. esubmitter@fda.hhs.gov. Please be sure to include your name, company name and contact information in the email. Otherwise, for
Regulatory questions, coniact the appropriaie office. See Addresses and Contacts for further details.
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Name Version Version Date Last Create Date Last Suomit Date
CDRH: Radiation Emitting Product (OMB NO. 0910-0025) 28 12/03/2019 11:53:3 PM =
CDRH: Radiation Emitting Product (OMB NO. 0910-0025) 26.1 08/18/2020 04:03:15 PM
CDRH: Report of Assembly of a Diagnostic X-Ray System 141 081212021 02:20:15 PM
CTP: Tobacco 904(a)(3) Template 13 10/03/2019 12:26:18 PM
CTP: Tobacco + Document i 11 09/05/2020 10:27:15 AM
CTP: Tobacca Product Ingredient Listing 29 10/04/2019 01:32:45 PM
CTP: Transmittal Form 22 10/03/2019 12:29:23 PM -
4]

Description of Selected Submission Type

Listing of Ingredients in Tobacco Products

On June 22, 2009, the President signed the Family Smoking Prevention and Tobacco Control Act (Tobacco Control Act) (Public Law 111-31) into law. Among its many provisions. the Tobacco
Control Act added section 904 o the Federal Food, Drug, and Cosmetic Act (the act) (21 U.5.C. 387d), establishing requirements for tobacco product ingredient submissions. To view the

Version: 3.54.00 Build 1 Tobacco Control Act, see Public Law citation (Pub. Law 111-31).
Last Updated: 05/05/2022

For your reference, see the Guidance: Listing of Ingredients in Tobacco Products.
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and to allow FDA to capture data in a more useful, structured format. These benefits enable Centers within the FDA to improve our review process and reduce lengthy review times.
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Submission Name: Testf Last Modified: ‘

Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View | Listing of Ingredients: Overview ‘

Notice: eSubmitter submission templates are updated monthly. Using updated templates for your submission helps ensure the latest fields and structure of each submission can be received and processed by the FDA. When you create a new submission, eSubmitter will provide the newer template. If you want to create a submission
from a prior submission, you can use the ‘Save As’ option and eSubmitter will load the newer template.

However, if eSubmitter updates are blocked by your IT infrastructure then eSubmitter cannot load the newer template. If eSubmitter updates are being blocked, check the FDA eSubmitter application history on the eSubmitter webpage to locate impertant CTF template updates so that you can perform manual reinstalls as needed.
hitp:/hvww.fda. gowForindustry/FDAe Submitter

Listing of Ingredients in Tobacco Products

On June 22, 2009, the President signed the Family Smoking Prevention and Tobacco Control Act (Tobacco Control Act) (Public Law 111-31) into law. The Tobacco Control Act amended the Federal Food, Drug, and Cosmetic Act (the distribution of tobacco products to protect the public health generally and to reduce tobacco
use by minors. To view the Tobacco Control Act, see Public Law citation (Pub. Law 111-31).

Complete the following question and answer form to list your ingredients or report any changes to your ingredients and submit the required data to FDA's Center for Tobacco Products via the FDA Electronic Submissions Gateway (ESG). To register with the FDA ESG, go to www fda gov/esg/.
For your reference, see the Guidance: Listing of Ingredients in Tobacco Products.

Please note, there are several icons within the application to help guide you. Most importantly. the light bulbs indicate additional instructions, definitions from the guidance document, and other helpful hints.

An agency may not conduct or sponsor, and a person is not required to respond to, a collection of information unless it displays a currently valid OMB control mumber. The OMB cantrol mumiber for this information collection is 0910-0650 (expires /X X/XXXX

Blue dots indicate required fields.

_ Qutline View
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2] Product and Ingredient Listing
T3 Product Listing
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Submission Name: Testd Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View

Listing of Ingredients: Submitter Role and Submission Type

Submitter Role and Submission Type > Submitter Identification > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Submitter Rele and Submission Type section. In this section you will be asked to identify your role and type of submission (new or update to previous submission).

Based on your answers fo this section, the application will tailor subsequent questions to ensure that you only answer those questions relevant o you.

Instructions and i .hhs.gov or 1-877-CTP-1373 (1-877-287-1373)) are available to help you create your e Submitter submissions for the Center for Tobacco Products.

" Outline View '
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Submission Name: Testd Last Modified:

Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Submission Type (2}

Submission Type
Please follow the instructions below to select submission status properlv.
Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form, including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include new products. Do not include a comprehensive list of all products.
Initial submission per 904(c)(1) for modification to existing product(s):
Initial submission per 904(c)(2) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco additive or increases in the quantity of an existing tobacco additive.
Initial submission per 904(c)(3) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive, or adds or increases an additive.
Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and make necessary updates to the submission product information.
*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falling under 904(c)(2).
** If you are only reporting an update or correction to contact information, do not use this form._ Instead, please submit a letter to FDA indicating the update or correction.
Please note: If you are discontinuing or resuming a discontinued product per 905(i)(3). you are required to submit an update to product list through 905 only and not 904. If you are adding a product. you must submit an update to product fist per 905(i)(3) as well as submit an ingredient listing for this product under 904(c)(1).
If you are unsure how to submit your information to CTP (e.g.. corrections), please contact the help desk at eSubmitter@fda hhs gov or by telephone at 1-877-CTP-1373.
For information regarding the section 904 requirements, please refer to the Guidance: Listing of T i in Tobacco Products.
Submission Type (Please ensure that all products under this submission meet the definifion of the checked submission type. Click lightbulb for definitions) 199
() Type a: Initial per 904(a)(1) for on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYQ, and smokeless tobacco) or August 8, 2016 (for other tobacco products)
2 Type b: Initial submission per 904(c)(1) for new product(s)
) Type c: Initial per 904{c)(1) for i ion t isting p (s
) Type d: Initial per 904(c)(2) for modificati isting pi {t
1 Type e: Initial ission per 904(c)(3) for i ion t isting product{s)*
(") Type - Amendment to correct previous product ingredient submission{s)™
> | Enterthe previous product ingredient submission tracking number:

Gl COrD [
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Submission Type ﬂ‘

Submission Type

Please follow the instructions below to select submission status properly.

Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form, including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only inchude new products. Do not inchude a comprehensive list of ll products

Tnitial submission per 904(c)(1) for modification to existing product(s):

Initial submission per 904(c)(2) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco additive or increases in the quantity of an existing tobacco additive.
Initial submission per 904(c)(3) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive, or adds or increases an additive.
Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and make necessary updates to the submission product information.

*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falling under 904(c)(2).
*+* If you are only reporting an update or correction to contact information. do not use this form. Instead, please submit a letter to FDA indicating the update or correction.

Please note: If you are discontinuing or resuming a discontinued product per 905(i)(3), you are required to submit an update to product list through 905 only and not 904. If you are adding a product. you must submit an update to product list per 005(i)(3) as well as submit an ingredient listing for this product under 904(c)(1).

If you are unsure how to submit your information to CTP (e.g., corrections), please contact the help desk at eSubmitter@fda hhs_gov or by telephone at 1-877-CTP-1373.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of i in Tobacco Products.

Submission Type (Please ensure that all products under this submission meet the definition of the checked submission type. Click lightoulb for definitions) 1L 3]
(@ Type a: Initial per 904(a)(1) for the market as of June 22, 2009 (for cigareties, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products)

() Type b: Initial submission per 904(c)(1) for new product(s)

() Type c: Initial ission per 904(c)(1) for

() Type d: Initial ission per 904(c)(2) for modil isti -

() Type e: Initial ission per 904(c)(3) for modil isti -

) Type f: Amendment to correct previous product ingredient submission{s)™

*> | Enter the previous product ingredient submission tracking number:

G COro |
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Submission Name: Test6 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Role of Submitter 2

Statutory Requirements

The requirements under section 904(a)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required ingredient information for products they manufacture and, for tobacco products that are imported, the required ingradient information is to be submitted by either the
foreign manufacturer or the importer of the product. This includes any tobacco product, whether for consumers or for further manufacturing.

Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If vou are reporting as an importer, and you are also a domestic tobacco product manufacturer, then you are also to submit the ingredient information for the
products you manufacture. In this situation, you would submit twice - once as an importer and once as a tobacco product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of Ingredients in Tobacco Products.

Please identify your role ® 9 | O Manufacturer]

L Importer

T




eSubmitter v3
CTP Tobacco Product Manufacturer form

[B] esubmitter - X ‘
File Edit View Table Output Tools Help

p e > 5
FEEN= RN BEE R EEEIE
Submission Name: Testf Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Role of Submitter

Statutory Requirements

foreign manufacturer or the importer of the product. This includes any tobacco product, whether for consumers or for further manufacturing.

Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

products you manufacture. In this situation, you would submit twice - once as an importer and once as a tobacco product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of Ingredients in Tobacco Products.

The requirements under section 904(2)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required ingredient information for products they manufacture and, for tobacco products that are imported, the required ingredient mformation is to be submitted by either the

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If you are reporting as an importer, and you are also a domestic tobacco product manufacturer. then you are also to submit the ingredient information for the

Please identify your role:

L]

(@) Manufacturer
() Importer

G CTOD D)
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Identification Information /J|

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Submitter Identification section. This section requests contact and address information for the responsible individual submitiing the Ingredient Listing submission.

GEEE COrD |
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Screen View

To use the eSubmitter's Address book, use the appropriate copy icons to the right.

‘Company Information

Company Name:

Company Headquarters D&B D-U-N-S® Number

‘Company Headquarters FDA Assigned Facility Establishment |dentification (FEI) Number:

‘Organization URL (e.g., www fda.gov):

‘Company Mailing Address:

Country:

Address - Line 1

Address - Line 2:

City:

State:

State, Province, or Territory Name

Zip or Postal Code

the

Prefic.

First Name/Given Name:

Middle Name.

Last Name:

Generational Suffic:

> | Generational Suffix, if Other:

Professional Suffix (e.g,, MD, Ph.D.J:

Position Title

Email Address

Telephone Number(s):

e —————

11
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Submission Name: TestT
Report Type: CTP: Tobacco Product Ingredient Listing

To use the eSubmitters Address book, use the apprapriate copy icons to the right

U.S. Agent Contact Information

Prefix

First Name/Given Name: [ ]

Middle Name:

Last Name: L]

> | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D. )

Paosition Title

[
[
[
Generational Suffix [ ~|
[
[
[
Email Address [

Telephone Number(s)

I % \:” % JEJ‘TJTJ 0 of 4 items in the list

Telephone Number(s)
Fax Number:
[ @ J‘ N = H @ J‘ 3 J 0 0f 1items in the list
Fax Number(s)

Mailing Address for U.S. Agent

Company Name: CH| |
Country ® || united states =
Address - Ling 1 @ | |

Address - Line 2: [ |

City: [ ] -

—_—
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View I.nmg of Ingredients: Product and Ingredient Listing ,]

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Preduct and Ingredient Listing section. In this section you will enter each product and the ingredients in each product.

Please note: You can import Product and Ingredient information by populating data onto the import Excel spreadsheet templates. The import spreadsheet templates can be found under the Info buiton on the respeciive Product and Ingredient screens. They can be accessed by clicking the
"import Spreadsheet Template" Iink under the Import Method section.

How will you provide Product, Component, Ingredient, and Identical Product Information? ] \)
(2 ) Enter product, and ingredient i ion manually on the following screens

) b) Enter product and ingredient information using separate CTP-provided and enter il ion manually

("1 ¢) Attach product, and ingredient i

using a single CTP-provided spreadsheet
() d) Attach your own spreadsheet

‘ 0 Further instructions will appear in this section upon selection of a response to the above guestion.

Tmport Method for E-Liquid Products:

Click on the link (Listing of Ingredients in Tobacco E-Liquid Products) to launch the pre-formatted Excel spreadsheet.
Tmport Method for Leaf-Wrapped Cigar Products:
Click on the link (Listing of Ingredients in Tobacco Leaf-Wrapped Products) to launch the pre-formatted Excel spreadsheet
Tmport Method for Ingredients in any Tobacco Product:

Click on the link (Listing of Ingredients in Any Tobacco Product) to launch the pre-formatted Excel spreadsheet

Attach the Product, Component, Ingredient spreadsheet.
P S =gy S

Title |

Name Date

0items in the list
Path

Outline View
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Submission Name: Test7 Last Modified: ‘
Date Packaged:

Report Type: CTP: Tobacca Product Ingredient Listing

Screen View ‘ Listing of Ingredients: Product Listing

Product Listing

=

Y | o= @ List | Detail

How to Enter Your Product(s):
You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here.

Data Entry Method:

1. To begin, click on the "Add" button to enter information about a product.
2. Then, advance fo the next screen where all ingredients should be entered for the selected product. You should enter all ingredients for a given product.

Import Method:

L. Click on the link (Import Spreadsheet Template for Product Identification) to launch the pre-formatied Excel spreadsheet.

3. Save the Excel spreadsheet file to an alierate location on your computer prior to filling in the requested information. You will need to navigaie fo the location of the file during the import process.
3. Mote: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4. Once you have eniered the information into the spreadsheet, click the Import Data bution on the top right corner of this screen next fo the yellow light bulb and follow the import wizard.

5. After all data is imported, you can click on the “List" button to view and verify the imported produci(s) information.

To see these instructions again, you may click on the "Info" bution.

3. Once you have entered all of the ingredient information for & product, you should return to this screen to list another product. If you do not need to list another product, you can continue to the next section afier Ingredients.

Outline View ﬁ
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacce Preduct Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Product Listing

Product Listing

@ ‘ = (=Y List || Detail

How to Enter Your Product(s)
‘You may enter data directly into this screen using the data entry method. As an alternative fo data entry. you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed to be imported here.

Data Entry Method:

1. To begin, click on the "Add" button to enter information about a product.
2. Then, advance fo the next screen where all ingredients should be entered for the selected product. You should enter all ingredients for a given product.

Import Method:
1. Click on the link (Import Spreadsheet Template for Product Identification) to launch the pre-f{List Data Message Dialog bd

3. Once you have entered all of the ingredient information for a product, you should return to this screen to list another product. If you do not need to list another product, you can continue fo the next section after Ingredients.

2. Save the Excel spreadsheet file to an alternate location on your computier prior to filling in th
3. Mote: Avoid changing the format of the spreadsheet as this may interfere with importing and
4. Once you have entered the information into the spreadsheet, click the Import Data button o
5. After all data is imported. you can click on the "List" bution to view and verify the imporied g

Selectan option

1 would like to add another Product

g the import process.

ort wizard.

(@ 1 am finished entering Product(s) and | would like to move to the next screen

To see these instructions again, you may click on the "Infe" button_

[ lgnore future addinavigation messages when exiting list screens?

Cancel

= Y
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How to Enter Your Product(s):

Data Entry Method:
1. To begin, click on the "Add" button to enter information about a product.

Import Method:

2. Then, advance to the next screen where all ingredients should be entered for the selected product. You should enter all ingredients for a given product.
3. Once you have entered all of the ingredient information for a product, you should return to this screen to list another product. If you do not need fo list another product, you can continue to the next section after Ingredients.

You may enter data directly into this screen using the data entry method. As an alternative to data entry. you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here.

1. Click on the link (Import Spreadsheet Template for Product Identification) to launch the pre-fi

List Data Message Dialog

X

2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in thi
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and
4. Once you have entered the information into the spreadsheet, click the Import Data button or]
5. After all data is imported, you can click on the "List" bution to view and verify the imported g

To see these instructions again, you may click on the "Info" button

Select an option

(® | would like to add another Product

("1 1am finished entering Product{s) and | would like to move to the next screen

[Z] ignore future addinavigation messages when exiting list screens?

ng the import process.

port wizard

- Outline View
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Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing

Product Listing

[ @ J - I @ J { List info )

PRODUCT IDENTIFICATION

Tebacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacco #202): L] ||

FDA-Assigned Tracking Number (TPa##)

Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567):

Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the product.): |

Select the type of product identification number. | - ‘
> ‘ If Other, please describe further.
Use of Product L] || v‘|
Is this tobacco product a co-package? ] ) Yes
) No
Product Category: [ ]

= ‘ I Other, please describe further.

Product Sub-Category:

> ‘ If Other, please describe further.

‘ l\ You will be prompted Iater to recard any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product. You do notthen need to submit separate ingredients listings for each ofthe products.
=

17



CTP Tobacco Product Manufacturer form

BB eSubmitter
Eile Edit View Table Output Tools Help

eSubmitter v3

w@9d B0 ed)

O]

EPERIDR

Submission Name: Test7?

Report Type: CTP: Tobacco Product Ingredient Listing
Screen View

Product Listing

l @ J = J < i ust J | o || ® | & J

PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacca #202); L] “ |
FDA-Assigned Tracking Number (TP#####4) TP
Ifthis product is under review or has been autherized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567):
Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the pif ;.. o Message Dialog % ‘ |
Select the type of product identification number. ‘ - |
Select an option
> ‘ If Other, please describe further: [ |
) I would like to add another Product
| Use of Product ® 1 am finished entering Product(s) and | would like to move to the next screen ® “ '”
[ Ignore future add/navigation messages when exiting list screens?
Is this tabacco product a co-package? @ | Tives
o | cancar | el
Product Category: ] ‘ - |
> ‘ If Other, please describe further: [ |

Product Sub-Category ‘ =l

> ‘ If Other, please describe further:

‘ !% You will be prompted Iater to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product. You do not then need to submit separate ingredients listings for each of the products.

—

Outline View
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This screen supports the data input of tabular Component information.

For help on how fo use this screen, view the screen insiructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

19



Bl esubmitter

File Edit View T

eSubmitter v3
CTP Tobacco Product Manufacturer form

x |

able Ouiput Tools Help

B O O RN NN

Submission Name: Test7 Last Modified:
‘Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged: |

e

Product " - ‘
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This screen supports the data input of tabular Component information.

For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

List Data Message Dialog

Select an option

) 1 would like to add another Component

(@ | am finished entering Component(s) and | would like to move to the next screen

[l 1gnare when exiting list
[| ok || conca |
S t =
-_
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Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Praduct Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product

Product
Component

How to Enter the Ingredient Information for each Product:
List all Ingredients for the product that was entered and selected In the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

Y

P = = List | Detail

You may enter data directly into this screen using the data entry method. As an aternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Piease note: If you already have a spreadsheet from a previous
SLUbmission, you can copy and paste your information intc the spreadsheet below.

Data Entry Method:

1. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient. click on the "Add" button to enter information about another ingredient.

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4, After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information
Import Method:

L. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updaies) to launch the pre-formatied Excel spreadsheet.
2. Save the Excel spreadsheet file to an alterate location on your computer prior to filling in the requested information. You will need to navigaie fo the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4. Once you have entered the information into the spreadsheet, click the Import Data bution on the top right corner of this screen next to the yellow light bulb and follow the import wizard.

5. After all data is imported. you can click "List" to view and verify the imported produci(s) information

To see these instructions again, you may click on the "Info" bution above

Qutline View
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Submission Name: Tesi7?
Report Type: CTP: Tobacco Product Ingredient Listing

Last Modified:
Date Packaged:

Screen View | Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
‘Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data eniry, please enter reaction products after entering all other ingredients.

p = @ List H Detail @ w ‘

You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you aiready have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet below.

Data Entry Method:
1. To begin, click on the "Add" button to enter information on a particular ingredient.

List Data Message Dialog X

2. Once you have entered the information about a particular Ingredient. click on the "Add" bul Seledt "
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified aboy electan option
4. After you have entered all ingredients for the selected product. return to the Product Identif| ) I would like to add another Ingredient ance to this screen to add the Ingredient information.
Import Method: (® | am finished entering Ingredient(s) and | would like to move to the next screen
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spi Identification Updates) to launch the pre-formatied Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filing in tf [l ignore future add/navigation messages when exiting list screens? o the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing an
4. Once you have entered the information into the spreadsheet, click the Import Data bution
5. After all data is imported, you can click "List" to view and verify the imporied produci(s) infc

ort wizard.

To see these instructions again, you may click on the "Info" button above

Qutline View
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Submission Name: Test?
Report Type: CTP: Tobacco Product Ingredient Listing

Date Packaged:

Last Modified: |
Listing of Ingredients: Ingredient Listing |

Screen View

Ingredient Listing By Product

Ky
Product
Component

W = @

List | Detail @

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.
You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheet from a previous
submission, you can copy and paste your information Into the spreadsheet below.
Data Entry Method:

1. To begin, click on the “Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" button fo enter information about another ingredient.

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested information. You will need to navigate to the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4, Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard.
5. After all data is imporied, you can click "List" to view and verify the imported product(s) information_

Screen Navigation Dialog X
To see these instructions again, you may click on the "Info" button above.

Select an option

) I would like to add/select a new Product
) I would like to add/select a new Component
(@ Continue to the Next screen

Cancel

Outline View _
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Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

3 = = List | Detail G ™ ‘

‘You may enter data directly info this screen using the data entry method. As an alternative fo data entry, you may enter this information info a pre-formatied spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet beiow.

Data Entry Method

1. To beqin, click on the "Add" button to enter information on a particular ingredient

2. Once you have entered the information about a particular Ingredient, click on the "Add" bution to enter information about another ingredient.

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen fo add the Ingredient information.
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested information. You will need to navigate to the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard.

5, After all data is imported, you can click "List" to view and verify the imported product(s) information.

Sereen Navigation Dialog X

To see these instructions again, you may click on the "Info" buiton above.
Selectan option

® | would like to add/select a new Product
2 Iwould like to add/select a new Component
(_ Continue to the Next screen

- Outline View
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‘Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged: |
Screen View I.nhlu of Ingredients: Product Listing JI
Product Listing 9 " l
l @ I = I = l petai I o J
Table of Tobacco Products.

= | ltem | ProductName | FDA-Assigned Tracking Number | STN Application #

Unigque Product ID

Type of Unique Product ID \ Type of Unique Product ID, If Other

Product Use

Co-Package? |

Product Category

> 1

| ]

109999 items in the list

R

- Qutline View
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List Data Message Dialog >

Select an option

I would like to add another Product
(@ 1 am finished entering Product(s) and | would like to move to the next screen

[~ Ignore future add/navigation messages when exiting list screens?

[[ o | concer |

10f9989 items in the list

Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing
ﬁ_ﬁﬁm
Product Listing
I @ | 2 | = ] [ Detat | o ]
Table of Tobacco Products
= ‘ Item | Product Name | FDA-Assigned Tracking Number | STN Application # Unigue Product 1D Type of Unigue Product ID | Type of Unique Product ID, If Other Product Use | Co-Package? ‘ Product Category
> 1

Outline View _‘
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| Report Type: CTP: Tobacco Product Ingredient Listing nﬁmm
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This screen supports the data input of tabular Component information.

For help on how fo use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.
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Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
e
Product | ~
[ @ d = J @ J List J Detail d info d @ d ® P

This screen supports the data input of tabular Component information.

For help on how fo use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

List Data Message Dialog X

Select an option

) | would like to add another Component
@1 1 am fini i would like to move to the next screen

[] Ignore future add/navigation messages when exiting list screens?

[ o ] concar |
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Submission Name: Tesi7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products afier entering all other ingredients.

] = @ List | Detail @ % |

You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note” If you already have a spreadsheet from a previous
submission, you can copy and paste your information inta the spreadsheet below.

Data Entry Method®

1. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" button to enter information about another ingredient.

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen fo enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior fo clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
1. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested information. You will need to navigate to the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard

5. After all data is imported, you can click "List" to view and verify the imported product(s) information

To see these instructions again, you may click on the "Info" button above.
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Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Praduct Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

[

P = = List | Detail

You may enter data directly into this screen using the data entry method. As an alternative to data entry. you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you aiready have a spreadshieet from a previous
SLUbmission, you can copy and paste your information intc the spreadsheet below.

Data Entry Method:

List Data Message Dialog X
1. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient click on the "Add"bu | -
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified aboy Gl
4, After you have entered all ingredients for the selected product, return fo the Product Identif|

Import Method:

) I would like to add another Ingredient ance to this screen to add the Ingredient information

‘#® lam finished entering Ingredient(s) and | would like to move to the next screen

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spi
2. Save the Excel spreadsheet file fo an alternate location on your computer prior fo filling in tf [ Ignore future addinavigation messages when exiting list screens?
3. Mote: Avoid changing the format of the spreadsheet as this may interfere with importing ans
4. Once you have entered the information into the spreadsheet, click the Import Data button of l,ﬁl
5. After all data is imported. you can click "List" to view and verify the imported produci(s) inf S

Identification Updates) to launch the pre-formatted Excel spreadsheet.
g the import process.

rt wizard.

To see these instructions again, you may click on the "Info" button above.

Outline View -

30



eSubmitter v3
CTP Tobacco Product Manufacturer form

| -

File Edit View Table Output Tools Help

BRI

ﬁe

B EEIEIEY

Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Ingredient Listing
Ingredient Listing By Product
Product
Component
> = @ List | Detail @ & ‘
How te Enter the Ingredient Information for each Product:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

‘You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheel froim a previous
submission, you can copy and paste your inforination into the spreadsheet below.
Data Entry Method:

1. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" bution to enter inf

3. Repeat steps 1 and 2 until all ingredienis have been entered for the product ideniified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen t
Import Method:

Screen Navigation Dizlog

Select an option

) 1 would like to addiselect a new Product the List and advance to this screen to add the Ingredient information.

(@ | would like to addiselect a new Component
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link- 1 | (") Continue to the Next screen

2. Save the Excel spreadsheet file fo an alternaie location on your computer prior fo filling in the requested in

3. Mote: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation
4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right
5. After all data is imporied, you can click "List" to view and verify the imported produci(s) information.

e for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
of the file during the import process.

| id follow the import wizard.

To see these instructions again. you may click on the “Info™ button above.

Outline View
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This screen supporis the data input of tabular Component information.

For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.
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Product H >
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This screen supports the data input of tabular Component information
For help on how to use this screen, view the screen instructions avallable by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

-, —————

List Data Message Dialog

X
Select an option

) I would like to add another Component

(@ | am finished entering Component{s) and | would like to move to the next screen

[1 Ignore future addinavigation messages when exiting list screens?

b
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CTP Tobacco Product Manufacturer form

- X
Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View | Listing of Ingredients: Ingredient Listing
Ingredient Listing By Product
Product
Component

@

How to Enter the Ingredient Information for each Product:

Lt |

Detail

Data Entry Method:

You may enter data directly into this screen using the data entry method. As an alternative to data eniry, you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed to be imporied here. Please nofe: If you aiready have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet below.

1. To begin, click on the "Add" button to enter information on a particular ingredient.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

To see these instructions again, you may click on the "Info" bution above.

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

2. Once you have entered the information about a particular Ingredient, click on the "Add" button to enter information about another ingredient.
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have eniered all ingredients for the selected product, return to the Product Identification screen fo enter another product. Select the next product in the List and advance o this screen to add the Ingredient information.
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
3. Save the Excel spreadsheet file to an alternate location on your computer prior fo filling in the requesied information. You will need to navigate to the location of the file during the import process.

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow lignt bulb and follow the Import wizard.
5. After all data is imported, you can click "List" to view and verify the imported product(s) information.

Outline View
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‘Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View | Listing of Ingredients: Ingredient Listing ﬁ
Ingredient Listing By Product 9 ‘ g |
Product
Component
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List | Detail

How to Enter the Ingredient Infermation for each Preduct:

List all ingredients for the product that was entered and selecied in the previous screen (displayed in the "Product” header above). To faciliiate data eniry, please enier reaction products after entering all other ingredients.

‘You may enter data directly into this screen using the data entry method. As an altemative to data entry. you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you aiready have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet below.
Data Entry Method:

List Data Message Dialog
1. To begin, click on the "Add" buiton to enter information on a particular ingredient.
2. Once you have eniered the information about a particular Ingredient, click on the "Add" bu Select an option
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified aboy
4. After you have entered all ingredients for the selecied product, return to the Product Identi ) 1would like to add another Ingredient
Import Method:

ance fo this screen to add the Ingredient information.

® Iam finished entering Ingredient(s) and | would like to move to the next screen

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spi
2. Save the Excel spreadsheet file to an altemate location on your computer prior to filling in tf [ lgnore future addinavigation messages when exiting list screens?
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing an

4, Once you have entered the information into the spreadsheet, click the Import Data button of

[ o | corcw | prvere
5. After all data is imported, you can click "List" to view and verify the imported product(s) infe —

To see these instructions again, you may click on the “Infe" button above.

Identification Updates) to launch the pre-formatied Excel spreadsheet.
g the import process.

Outline View _s
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Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
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List || Detail

How to Enter the Ingredient Information for each Preduct:

submission, you can copy and paste your information into the spreadsheef below.
Data Entry Method:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

You may enter data directly into this screen using the data eniry method. As an alternative fo data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imporied here. Piease nofe: If you already have a spreadsheetf from a previous

1. To begin, click on the "Add" bution fo enier information on a particular ingredient.

Screen Navigation Dialog

2. Once you have entered the information about a particular Ingredient, click on the "Add" bution 1o enter inif

3. Repeat sieps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen t
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. 1
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested in

Selectan option

) I would like to addiselect a new Product
) I would like to addiselect a new Component
(@ Continue to the Next screen

the List and advance to this screen fo add the Ingredient information.

ite for Ingredient |dentification Updates) to launch the pre-formatied Excel spreadsheet.
of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation
4. Once you have entered the information into the spreadsheet, click the iImport Data button on the top right

5. After all data is imported. you can click "List" to view and verify the imported product(s) information.

id follow the import wizard.

To see these instructions again, you may click on the "Info™ button above.

Outline View _il
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Report Type: CTP: Tobacco Product Ingredient Listing

‘ :% Ifyou used a spreadsheet to import product and ingredient data, you may attach it to the Additional Submission Documents attachment question.
=

Caver Letter

If you have a cover lefter, please attach it here.

File Attachment “ R EY “

Additional Submission Documents

Please attach any additional documentation relevant o this (e.g., Import template for Product Identification, chart, graph, index, table of contents, etc.).

EYEYEEY EYEY 0 items in the list
Title | Name. Date size Path ]

4l bl

Submission Comments

Please enter any submission comments below.
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CTP Tobacco Product Manufacturer form

eSubmitter - X |

file Edit View Table Output Tools Help
] Q@ &+ Ba]e 9

i<

Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Confirmation: Instructions )‘

Introduction > Submitter Identification > Ingredient Listing > Confirmation

You are now in the Cenfirmatien section. This section contains a confirmation statement, and requests additional contact and address information, as needed. Your last step in this section is to package your submission for transmission to the Center for Tobacco Products.

The packaging process will validate that you have completed data entry.

= i
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CTP Tobacco Product Manufacturer form

[E] esubmitter
File Edit View Table Output Tools Hely

3/9/d]|BID) 8lclo)|s|@) +/2 0 @) 9

Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing

Screen View

& Warning: A willfully false statement is a criminal offense, U.S. Code, title 18, seclion 1001.

The data and information in this submission have been reviewed and, to the best of my knowledge, are cerified to be true and accurate. | agree to report changes to this information as required under section 904(c) of the act.

Identify the person submiting this form:

To use the eSubmitters Address book, use the appropriate copy icons to the right

Contact Information

Prefix

First Name;

Niddle Name:

Last Name

Generalional Suffix;

Generational Suffix, if Other:

Professional Suffix

Paosition Title:

Email Address:

Telephone Number(s)

R EEYEY

0 of 4 items in the list

Telephone Number(s) 0
=] |2
Fax Number(s)
1EQ‘L“L\ 34 00f 1ftems In the list
Fax
=]

Mailing Address

Outline View m

_—
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CTP Tobacco Product Manufacturer form

5] esubmitter

File Edit View Table Ouiput Tools Help
BE IR EREEIDIE

X I
Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Confirmation: Package Files for ._J‘
@ You have reached the end of this submission. You may now package the submission and transmit itto CTP via the CTP Portal or ESG or on CO-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDAto provide you with an
automated acknowledgement of receipt.

Atthis time, you may save and close this submission to return to it at a later time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu
If you would like to package this submission at this time in preparation for ransmitting to FDA, please begin the packaging process by selecting Oulput > Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual and/or Quick Guide.

If you would like to prepare another submission to fuffill other FDA requirements, please select "New” from the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.

R e g ’ .
- Outline View
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CTP Tobacco Product Manufacturer form

File Edit View Table Output Tools Help
BN

P
G2

Submission Name: Test?

Report Type: CTP: Tobacco Product Ingredient Listing

BEREERDR

Last Modified:
Date Packaged:

Screen View ‘l‘ firmati Package Files for

-

You have reached the end of this submission. You may now package the submission and fransmit it to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
automated acknowledgement of receipt

Atthis time, you may save and close this submission to return to it at a later time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu

If you would like to package this submission at this time in preparation for transmitiing to FDA, please begin the packaging process by selecting Output > Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are and all have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual andfor Quick Guide.

If you would like to prepare another submission to fulfill other FDA requirements, please select "New” from the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.

Waning X

You have reached the end of the Submission form. However, the report is incomplete due to missing
data. Selectthe Missing Data Report from the Output menu to easily identify all missing responses.

- Outline View
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CTP Tobacco Product Manufacturer form

[5] esubmitter -

File Edit View Table Output Tools Help
sod|a T 6/eo @ «sa e ol

Submission Name: Test7 Last Modi

Report Type: CTP: Tobacco Preduct Ingredient Listing Date Packaged:

ified:

Screen View ‘ Listing of Ingredients: Submission Type

Submission Type

Please follow the instructions below to select submission status properly.

TInitial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form, including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include new products. Do not include a comprehensive list of all products.

TInitial submission per 904(c)(1) for modification to existing product(s):

Initial submission per 904(c)(2) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco additive or increases in the quantity of an existing tobacco addifive.
TInitial submission per 904(c)(3) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive, or adds or increases an additive.
Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and make necessary updates to the submission product information.

*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falling under 904(c)(2).
** If you are only reporting an update or correction to contact information, do not use this form. Instead, please submit a letter to FDA indicating the update or correction.

Please note: If vou are discontinuing or resuming a discontinued product per 905(1)(3). you are required to submit an update to product list through 905 only and not 904. If you are adding a product, you must submit an update to product list per 903(i)(3) as well as submit an ingredient listing for this product under 904(c)(1).

If you are unsure how to submit your information to CTP (e.g.. corrections). please contact the help desk at eSubmitter@fda hhs_gov or by telephone at 1-877-CTP-1373.

ey

For information regarding the section 904 requirements, please refer to the Guidance: Listing of in Tobacco Products.
Submission Type (Please ensure that all praducts under this submission meet the definition ofthe checked submission type. Click lightoulb for definifions)
Type a: Initial i per 904(a)(1) for the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products)
@ TYpe b: Initial submission per 904(c)(1) for new product(s)
Type c: Initial ission per 904(c){1) for modification to existi
) Type d: 1] ission per 904(c)(2) for i ion istil *
) Type e Initial ission per 904(c)(3) for i ion

) Type f: Amendment to correct previous product ingredient submission(s)™

* | Enter the previous product ingredient submission tracking number:

T T & - .
_ Outline View ﬁ
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CTP Tobacco Product Manufacturer form

[5] eSubmitter - X

File Edit View Table Qutput Tools Help
Bode0]eeo 3@ 3o e el

Submission Name: Test7 Last Modified: ‘

Report Type: CTP: Tabacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Role of Submitter

Statutory Requirements

The requirements under section 904(a)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required ingredient information for products they manufacture and, for tobacco products that are imported, the required ingredient information is to be submitted by either the
foreign manufacturer or the importer of the product. This includes any tobacco product, whether for consumers or for further manufacturing.

‘Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If you are reporting as an importer, and you are also a domestic tobacco product manufacturer, then you are also to submit the ingredient information for the
products you mamufacture. In this situation. you would submit twice - ance as an importer and once as a tobacca product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of i in Tobacco Products.

Please identify your role: @Y | @ Manufacturer)

 Importer

G ﬁ
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eSubmitter v3
CTP Tobacco Product Manufacturer form

[B] esubmitter - X I
File Edit View Table Output Tools Help
r = A | & . o
B EE=n SR ERE R
‘Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: |dentification Information 4 ‘

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Submitter Identification section. This section requests contact and address information for the responsible individual submitting the Ingredient Listing submission.

— —
- -
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CTP Tobacco Product Manufacturer form

[5] esubmitter - x
File Edit View Table Output Tools H

FEEEREREERERDE

Submission Name: Tesi7 Last Modified:
Report Type: ‘CTP: Tobacco Product Ingredient Listing Date Packaged:

To use the eSubmitter's Address book, use the appropriate copy icons to the right. ‘ ﬁ @

‘Company Information

Company Name: @

Company Headquarters D&B D-U-N-8& Number

‘Company Headquarters FDA Assigned Facility Establishment Identification (FEI) Number:

Organization URL (a.g., www fda.gov)

Company Mailing Address:

Country:

Address - Line 1

Address - Line 2:

State:

[
[
City: @ |
State, Province, or Territory Name |

Zip or Postal Code:

Auth d i ible official i the

Prefic

First Name/Given Name. L]

Widdle Name:

Last Name: L]

* | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.):

Paosition Title:

Email Address:

|
[
[
[
Generational Suffix: | vJ
[
[
[
[

Telephone Mumber(s)
i

"Gutine view

45



eSubmitter v3
CTP Tobacco Product Manufacturer form

Submitter - X

PFENIFNERREERERDE

To use the eSubmitter's Address book, use the appropriate copy icons to the right

U.S. Agent Contact Information

Prefix

First Name/Given Name: L ]

Widdle Name:

Last Name: ?

> | Generational Suffix, If Other

Professional Suffix (e.g., MD, Ph.D.):

Position Title

\
\
[
[
Generational Suffix: ‘ -
[
[
[
|

Email Address:

Telephone Number(s):

&J'M‘Ll @ J‘LJ 0 of 4 items in the list

Telephone Number(s)
Fax Number:
mlij‘ﬂlﬁ‘ 3 0 0f 1 items in the list
Fax Number(s)

Mailing Address for U.S. Agent

Company Name @ | |
Country @ || united states M
Address - Line 1 @ | J

Address - Line 2 [ |

ci _e ~|
i ) T —

e
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CTP Tobacco Product Manufacturer form

[B] esubmitter - X
File Edit View Table Output Tools Help

FEE =Y E=IEIEY

Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing

Last Madified:

Date Packaged:
Screen View -1 gr Pr and Ingredit Listing

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Preduct and Ingredient Listing section. In this section you will enter each product and the ingredients in each product.

Please note: You can import Product and Ingredient i ion by
"Import Spreadsheet Tempiate" link under the limport Method section.

data onto the import Excel spi The import sp

can be found under the Info button on the respective Product and Ingredient screens. They can be accessed by clicking the

How will you provide Product, Component, Ingredient, and Identical Preduct Information?

2 a) Enter product, component, and ingredient information manually on the following screen

) b) Enter product and i ient i ion using separate CTP-provided

and enter i manually
() ) Attach product, and ingredient it tion using a single CTP-provided spreadsheet

() d) Attach your own spreadsheet

‘ 0 Further instructions will appear in this section upon selection of a response ta the above question

TImport Method for E-Liquid Products:

Click on the link (Listing of Ingredients in Tobacco E-Liquid Products) to launch the pre-formatted Excel spreadshest

Tmport Method for Leaf-Wrapped Cigar Products:

Click on the link (Listing of Ingredients in Tobacco Leaf-Wrapped Products) to launch the pre-formatted Excel spreadsheet.

Tmport Method for Ingredients in any Tobacco Product:

Click on the link (Listing of T

in Any Tobacco Product) to launch the pre-formatted Excel spreadsheet.

Altach the Product, Compoenent, Ingredient spreadsheet.
FRIRY B YRS

Title | Name Date

0 items in the list

Qutline View
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eSubmitter v3
CTP Tobacco Product Manufacturer form

x
Tools Help

AECIE=RERIEERSEEIDIR

Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Product Listing (v} H‘ & I
l @ | = J = J List I Detil J inio J | > J ® i
Table of Tobacco Products

> [ item | ProduciName | FDA-Assigned Tracking Number | STN Appli # Unique ProductiD__| Type of Unique Product ID. I Type of Unique Product ID, If Other |_ProductUse | Co-Package? | Product Category I

=1 1 \ I I

|

1 09999 items in the list

Outline View .
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eSubmitter v3
CTP Tobacco Product Manufacturer form

File Edit View Table Output Tools Help

FEEEN AR EREEDIR

Submission Name: Test?

CTP: Tobacco Product Ingradient Listing

Report Type:
Product Listing
[ 2 I = I = ) [ List I Detal I infa | |
Table of Tobacco Products
> | item | Productiame | FDA-Assigned Tracking Number | STN Application # Unique Product ID Type of Unigue Product ID Type of Unigue Product D, If Other |_ProductUse | Co-Package? | Product Category
> ‘ 1

List Data Message Dialog

‘Select an option

1 would like to add another Product
® | am finished entering Product(s) and | would like to move to the next screen

[] ignore future add/navigation messages when exiting list screens?

1079999 items in the list

e 1
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file Edit View Table Output Tools Help

eSubmitter v3
CTP Tobacco Product Manufacturer form

@930 6/cd

FEEREE

89

List Data Message Dialog >

Select an option

@ | would like to add another Product

 1am finished entering Product(s) and | would like to move to the next screen

[~ Ignore future add/navigation messages when exiting list screens?

T o ] oo

10f9989 items in the list

Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing
ﬁ_ﬁﬁm
Product Listing
I @ | 2 | = ] [ Detat | o ]
Table of Tobacco Products
= ‘ Item | Product Name | FDA-Assigned Tracking Number | STN Application # Unigue Product 1D Type of Unigue Product ID | Type of Unique Product ID, If Other Product Use | Co-Package? ‘ Product Category
> 1

G oD e
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eSubmitter v3
CTP Tobacco Product Manufacturer form

eSubmitter - X
BYd 8060022« a|e o)
Product Listing a " & J
| @ | - J[ @ J l List Jl Detail J[ Info J [ A J| [ J

PRODUCT IDENTIFICATION

Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.q., Acme Lights 100°'s or Acme Reconstituted Tobacco #202): L] “

FDA-Assigned Tracking Number (TPE#####2):

Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567).

Product dentification Number (At least one product identification number must be provided if needed to uniquely identify the product.): [

Selectthe type of product identification number. | M
» | If Other, please describe further: [ |
| Use of Product L] “ vl‘
Is this tobacco product 3 co-package? [ ] ) Yes
) No
Product Category: ] | - |
> | If Other, please describe further: [ |

Product Sub-Category |

L4 | If Other, please describe further: |

‘ :% You will be prompted later to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product. You do notthen need to submit separate ingredients listings for each of the products.
=
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CTP Tobacco Product Manufacturer form

B2 eSubmitter

File Edit View Table Ouiput Tools Help

eSubmitter v3

— % |

EECIE RO EREEE]

Submission Name: Test?
Report Type: CTP: Tobacco Product Ingredient Listing

Last Modified
Date Packaged:

Product Listing
l @ I 2 | - I st | [ o I > | 2
PRODUCT IDENTIFICATION
Tobacce Product BrandiSub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacco #202). @ ‘\ |
FDA-Assigned Tracking Number (TP###sS); TP

Ifthis productis under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (2.g., SE1234567):

Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the pi

List Data Message Dialog x
Select the type of product identification number: ‘ - ‘
Select an option
> | If Other, please describe further [ |
) I would like to add another Product
‘ Use of Product ® 1am finished entering Product(s) and | would like to move 1o the next screen ® “ ,“
[1 Ignore future addinavigation messages when exiting list screens?
Is this tobacco product a co-package? ] ) Yes
I No
Product Category: @ ‘ - ‘
> | If Other, please describe further. ‘ ‘
Product Sub-Category: ‘ - ‘
= | I Other, please describe further. ‘ ‘

% You will be prompted later to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product You do notthen need to submit separate ingredients listings for each of the products

- @)
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eSubmitter v3
CTP Tobacco Product Manufacturer form

[5] esubmitter
Hle Edit View Table Output Tools Help

BRI EREE
| ; \|
I @ d = J @ J | List J Detail J iio d| @ J @ P

This screen supports the data input of tabular Component information.

For help on how to use this screen, view the screen instructions avallable by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

53



B esubmitter

eSubmitter v3
CTP Tobacco Product Manufacturer form

File Edit View Table Output Tools Helf 2
FEEEEERIPEFRE RO
Submission Name: Test7 Last Modified:
] Report Type: ‘CTP: Tobacco Product Ingredient Listing Date Packaged:
v
Product H
[ & J - d List ] Detai J info J| @
This screen supports the data input of tabular Component information.

For help on how to use this screen. view the screen instructions available by selecting the 'Hint' option (denoted by a lightbuld) at the top right of the screen.

List Data Message Dialog

Select an option

1 1 would like to add another Component

(® | am finished entering Component(s) and | would like to move to the next screen

[_] Ignore future addinavigation messages when exiting list screens?

z
d ® J

“Outline View b
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eSubmitter v3
CTP Tobacco Product Manufacturer form

8] esubmitter
File Edit View Table Output Tools Help

- x
5 Ty A2y || ¢ - 3 >
BB =R EDIEEREREEIE
Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Ingredient Listing
Ingredient Listing By Product ] ‘ % ‘
Product
Component
] = @ List | Detail @ = ‘
How to Enter the Ingredient Information for each Product:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

You may enter data directly into this screen using the data enfry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already frave a spreadsheet from a previous
submission, you can copy and paste your Information into the spreadsheet below.

Data Entry Method:
1. To begin, click on the "Add" button to enter information on a particular ingredient
2. Once you have entered the information about a particular Ingredient. click on the "Add™ bution fo enter information about another ingredient.
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return fo the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.
Import Methed:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.

2. Save the Excel spreadsheet file o an alternate location on your computer prior fo filling in the requested information. You will need to navigate to the location of the file during the import process.
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4. Once you have entered the information into the spreadsheet, click the Import Data bution on the top right corner of this screen next to the yellow light bulb and follow the import wizard.
5. After all daia is imported, you can click "List" to view and verify the imported produci(s) information.

To see these instructions again, you may click on the "Info" buiton above.

G COD D
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File Edit View Table Output Tools Help

BN S = | ETENE)

Q@

. % ‘
BEPRRDIR

‘Submission Name: Tesi? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Ingredient Listing ‘
Ingredient Listing By Product ? | § |
Product
‘Component
o = G List || Detail @ ® |
How to Enter the Ingredient Information for each Product:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

You may enter data directly into this screen using the data entry method. As an aliernative to data entry, you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed o be imported here. Please note: if you aiready have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet beiow.

Data Entry Method

List Data Message Dialog x
1. To begin, click on the "Add" button to enter information on a particular ingredient.
2. Once you have entered the information about a particular Ingredient, click on the "Add" buj Select an option
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified abo
4, After you have entered all ingredients for the selected product, return to the Product Identif| 3 1 would like to add another Ingredient
Import Method:

ance to this screen to add the Ingredient information.

@) 1am finished entering Ingredient(s) and | would like to move to the next screen
1. You MUST select a Submission Type (the first question of this form) prior fo clicking the spi

Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file fo an alternate location on your computer prior fo filling in tf ] Ignore future add/navigation messages when exiting list screens? g the import process.
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing an
4. Once you have entered the information into the spreadsheet, click the Import Data button o m T ‘ rt wizard.
5. After all data is imported, you can click "List" to view and verify the imported produci(s) inft =

To see these instructions again, you may click on the "Info" button above.

= |
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file Edit View Table Output Tools Help

x
B E = m R E R EEE )
Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Ingredient Listing
Ingredient Listing By Product

[ad
Product
Component

op =1

List Detail

@ ® |
How to Enter the Ingredient Information for each Preduct:

List all ingredients for the product that was entered and selecied in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

You may enter data direcily into this screen using the data eniry method. As an alternative to data eniry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet below.
Data Entry Method:

o . i i X Screen Navigation Dizlog x

1. To begin, click on the "Add" button to enter information on a particular ingredient

2. Once you have entered the information about a particular Ingredient, click on the "Add" button to enter inff

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above. SRR

4, After you have entered all ingredients for the selected product, retumn to the Product Identification screen ® [ would iike fo add/selecta new Produci the List and advance fo this screen to add the Ingredient information.
Import Method:

_» 1 would like to add/select a new Component
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link.

) Continue to the Next screen ite for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested in
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation

of the file during the import process.
4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right | d follow the import wizard.
5. After all data is imported, you can click "List" to view and verify the imported product(s) information =

To see these instructions again. you may click on the "Info" button above.

Qutline View
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eSubmitter

File Edit View Table Output Tools Help

x
BRI E RSP EERE IO
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Product Listing Q || & J
I @ I 2 | - | Lst | ea | ito ] [ . J ® J
Table of Tobacco Products
= Item Product Name FDA-Assigned Tracking Number STN Application # Unigue Product ID Type of Unique Product ID Type of Unique Product D, If Other Product Use Co-Package? Product Category
1
> 2

2079999 items in the list

—

Outline View .
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eSubmitter - e |
File Edit View Table Output Tools Help
BlolbaDelco @& +3ae o
Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Preduct Ingredient Listing Date Packaged:
Product Listing Q " & J
I @ | = | ust I Deta | ito ] [ ] A i
Table of Tobacco Products
= Item Product Name FD: igned Tracking Number STN Unigue Product ID Type of Unique Product ID Type of Unique Product ID, If Other Product Use Co-Package? Product Category
1
> 2

List Data Message Dialog X

Select an option

) | would like to add another Product
(® | am finished entering Product(s) and | would like to move to the next screen

["] Ignore future addinavigation messages when exiting list screens?

(| o ] conce

2 0f9999 items in the list

- -2 - 1
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Product H

[ ) d = J = J | List J Detai d inio d | @ J % d|

This screen supports the data input of tabular Component information.

For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.
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Submission Name: Test7?

Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Sgreen Yiew —
?]
Product ”

z
[ @ J 2 J a d st J Detal J into d | N J ® J|

This screen supporis the data input of tabular Component information.

For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

List Data Message Dialog x

‘Select an option

> 1 would like to add another Component
w1 ished entering C next screen

[~ Ignore future addinavigation messages when exiting list screens?

B == oo o T
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Ingredient Listing
Ingredient Listing By Product
Product
‘Component
b = (=Y List H Detail @ w5 ‘
How to Enter the Ingredient Information for each Product:

List all ingredients for the product that was entered and selecied in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

‘You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet below.
Data Entry Method:

1. To begin. click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient. click on the "Add" button to enter information about another ingredient.
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient ldentification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filing in the requested information. You will need to navigate to the location of the file during the import process.
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard.
5. After all data is imported, you can click "List" to view and verify the imported product(s) information.

To see these instructions again, you may click on the "Infe™ button above.

Qutline View
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Submitter - X

Eile Edit View Table Output Tools Help
FEEIENREREERERDR
Report Type: CTP: Tobacco Product Ingredient Listing

Submission Name: Test7?

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry. please enter reaction products after entering all other ingredients.

- - - = ] oot > v |

‘You may enter data directly into this screen using the data entry method. As an alternative to data eniry. you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please nofe: If you aiready have a spreadsheet from a previous
submission, you can copy and paste your information info the spreadsheet below.

Data Entry Methed

List Data Message Dislog X

1. To begin, click on the "Add" button to enter information on a pariicular ingredient

3. Once you have entered the information about a particular Ingredient, click on the "Add" bu Seledt "
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified aboy e el
4. After you have entered all ingredients for the selected product, return to the Product Identi ) | would like to add another Ingredient ance to this screen to add the Ingredient information.
Import Method: (@ | am finished entering Ingredient(s) and | would like to move to the next screen
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spi Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in tf [ lgnore future addinavigation messages when exiting list screens? g the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing an
4. Once you have entered the information into the spreadsheet, click the Import Data button o
5 After all data is imported. you can click "List" to view and verify the imported product(s) inf

jort wizard.

ok

To see these instructions again, you may click on the "Info™ button above.

Y | B |

63



eSubmitter v3
CTP Tobacco Product Manufacturer form
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Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Praduct Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product ? | & ‘
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

> = @ List | Detail @ ® ‘

You may enter data directly into this screen using the data entry method. As an alternative fo data entry. you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you aiready have a spreadsheet from a previous
submission, you can copy and paste your Information into the spreadsheet below.

Data Entry Method:

Screen Navigation Dialog X

1. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add™ button to enter infi
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above. Seledtniont oy
4. After you have entered all ingredients for the selected product, return fo the Product Identification screen t

Import Method:

3 I'woukl ke to addiselect & new Product the List and advance to this screen to add the Ingredient information

» 1 would like to addiselect a new Component

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheetlink. T | @ Continue to the Next screen ite for Ingredient |dentification Updates) to launch the pre-formatted Excel spreadsheet.
3. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested in of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation
4, Once you have eniered the information into the spreadsheet, click the Import Data bution on the top right

Ccancel ‘ d follow the import wizard.
5. After all data is imported, you can click "List" to view and verify the imported produci(s) information —

To see these instructions again, you may click on the "Info" button above.

Outline View
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File Edit View Table Output Tools Help

BB C = I ENEIE]

Submission Name: Test?
Report Type: ‘CTP: Tobacco Product Ingredient Listing

'g/) Ifyou used a spreadsheet to import product and ingredient data, you may attach it to the Additional Submission Documents attachment question
=

Caver Letter

If you have a cover letter, please attach it here

File Attachment

EYEYIN

Additional Submission Documents

Please attach any additional documentation relevant to this submission (e.g., Import Spreadsheet template for Product Identification, chart, graph, index, table of contents, efc.).

0items in the list

EXRYIEEYEN ‘LJ

Title. Name ‘ Date Size. Path

il

Submission Comments

Please enter any submission comments below.
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File Edit View Table Output Tools Help

Lud/a0eleols

Submission Name: Test?
CTP: Tobacco Product Ingredient Listing

ERE

99

Report Type:

Screen View ‘ Confirmation: Instructions

Last Modified:
Date Packaged:

-]

Introduction > Submitter Identification > Ingredient Listing > Confirmation

You are now in the Confirmation section. This section contains a confirmation statement, and requests additional contact and address information, as needed. Your last step in this section is fo package your submission for transmission to the Center for Tobacco Products.
The packaging process will validate that you have completed data entry.

= )
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Submission Name: Test7?
Report Type: CTP: Tobacco Product Ingredient Listing

& Warning: A willfully false statement is a criminal offense, U.S. Code, title 18, section 1001

The data and information in this submission have been reviewed and, to the best of my knowledge, are certified to be frue and accurate. | agree to report changes to this information as required under section 904(c) ofthe act

Identify the person submitting this form: ] ||

To use the eSubmitter's Address book, use the appropriate copy icons to the right.

Contact Information

Prefic.

First Name [ |

Middle Name: [ |

Last Name: [ |

Generational Suffix:

Generational Suffix, if Other.

]
|
Professional Suffix [ |

Position Title: [ |

Email Address: | |

!lﬁ i}ii‘ 15} 2 0 0f 4 tems in the list
Telephone Number(s)

Fax Number(s)

(_}i il ?J} & 00f 1 tems in the list

Fax Number(s)

Mailing Address

il

% QR Octine View
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eSubmitter
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File Edit View Table Output Tools Help
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[EXEE) 600 @2 +Bn B e
Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | C ion: F ge Files for -

You have reached the end of this submission. You may now package the submission and transmit itto CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure fransmission and enables the FDA te provide you with an
automated acknowledgement of receipt

Atthis ime, you may save and close this submission to return to it at a later time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission frem the Intra Screen or Open from the File Menu.

If you would like to package this submission at this ime in preparation for ransmitting to FDA, please begin the packaging process by selecting Output > Package Files for Submission or by clicking the Package icon from the top toolbar. I any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required are and all documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual andior Quick Guide.

If you would like to prepare another submission to fulfill other FDA requirements, please select "New” from the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.

" Outline View [ﬁ
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BERERIDIE

Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Ci i F ge Files for

-]

You have reached the end of this submission. You may now package the submission and transmit it o CTP via the CTP Portal or ESG or on CD-ROM in order to fuffill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
automated acknowledgement of receipt

Atthis time, you may save and close this submission to return to it at a later ime. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu
If you would like to package this atthis time in for

1o FDA, please begin the packaging process by selecting Output > Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual andior Quick Guide.

If you would like to prepare another submission to fulfill other FDA requirements, please select "New” frem the File Menu to begin compiling a new submission and be sure to selectthe appropriate submission type

Warning X

You have reached the end of the Submission form. However, the report is incomplete due to missing
data. Select the Missing Data Report from the Output menu to easily identify all missing responses.

Close

R A = £
- Outline View
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‘Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Submission Type ﬁ‘

Submission Type

Please follow the instructions below to select submission status properly.

Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form, including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include new products. Do not include a comprehensive list of all products.

Tnitial submission per 904(c)(1) for modification to existing product(s):

Initial submission per 904(c)(2) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco additive or increases in the quantity of an existing tobacco additive.
Initial submission per 904(c)(3) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive, or adds or increases an additive.
Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and make necessary updates to the submission product information.

*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falling under 904(c)(2).
** If you are only reporting an update or correction to contact information, do not use this form_ Instead. please submit a letter to FDA indicating the update or correction.

Please note: If you are discontinuing or resuming a discontinued product per 903(i)(3). you are required to submit an update to product list through 905 only and not 904. If you are adding a product, you must submit an update to product list per 905(1)(3) as well as submit an ingredient listing for this product under 904(c)(1).
If you are unsure how to submit your information to CTP (e.g.. corrections). please contact the help desk at eSubmitter@fda hhs.gov or by telephone at 1-877-CTP-1373.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of T ients in Tobacco Products.

Submission Type (Please ensure that all products under this submission meet the definition of the checked submission type. Click lightoulb for definitions) 19Q

() Type a: Initial per 904{a)(1) for the market as of June 22, 2009 (for cigarettes, cigareite tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products)
ial submission per 904(c)(1) for new product(s)

per 904{c)(1) for i ion isting
per 904(c)(2) for modificati st -
per 904{c)(3) for i ion isting

) Type f: Amendment to correct previous product ingredient submission(s)*™*

> | Enter the previous product ingredient submission tracking number.

[ouineview JRIV— > ]
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X
R EFEIE
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Role of Submitter

Statutory Requirements
‘The requirements under section 904(a)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required mgredient mformation for products they manufacture and. for tobacco products that are imported, the required ingredient information is to be submitted by either the
foreign mamufacturer or the importer of the product. This includes any tobacco product. whether for consumers or for further manufacturing

‘Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If you are reporting as an importer, and you are also a domestic tobacco product manufacturer, then you are also to submit the ingredient information for the
products vou manufacture. In this situation, you would submit twice - once as an importer and once as a tobacco product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of in Tobacco Products.

Please identify your role

@ | @ Manufacturer

) Importer

=
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Submission Name: Tesi7 Last Modified:

Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Identification Information )|

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Submitter Identification section. This section requests contact and address information for the respensible individual submitting the Ingredient Listing submission.

e )
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[8] esubmitter X
Hle Edit View Table Output Tools H;

3 8/ [B]D)]6/0 0 @ & +/3 o 89
] I?‘epumm Z:ﬁ?TohaccoFmdudVng’edeﬂlLisﬁng Df;m;d:

To use the eSubmitter's Address book, use the appropriate copy icons to the right.

‘Company Information

‘Company Name:

‘Company Headquarters D&B D-U-N-S® Number:

Company Headquarlers FDA Assigned Facility Establishment Identification (FEI) Number.

Organization URL (e.g., www.fda.gov):

Company Mailing Address:

Country:

Address - Line 1

Address - Line 2:

city

State:

State, Province, or Territory Name

Zip or Postal Code

Prefix:

First Name/Given Name.

Middle Name:.

Last Mame

Generational Suffic:

* | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.)

Position Title

Email Address:

Telephone Number(s).

Qutline View H
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CTP Tobacco Product Manufacturer form

PECIEFIREREERERDIR

Submission Name: Test?
Report Type: (CTP: Tebacco Product Ingredient Listing

Screen View

To use the eSubmitters Address boak, use the appropriate copy icons ta the right

U.S. Agent Contact Information

Prefix.

First Name/Given Name:

Widdle Name:

Last Name:

Generational Suffix:

* | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.)

Position Title:

Email Address:

Telephone Number(s)

YRR EY

0 of 4 items in the list

Telephone Number(s)

i

Fax Number:

EYEYEYEXEY

0 of 1 items in the list

Fax Number(s)

Mailing Address for U.S. Agent

Company Name

Country.

L]
i
L4

Address -Line 1

Address -Line 2:

Cli
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Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tabacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Product and Ingredient Listing

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Preduct and Ingredient Listing section. In this section you will enter each product and the ingredients in each product.

Please note: You can import Product and Ingredient information by populating data onto the import Excel spreadsheet tempiates. The impoit spreadsheet tempiates can be found under the Info button on the respective Product and Ingredient screens. They can be accessed by ciicking the
"limport Spreadsheet Template” link under the Import Method secfion.

How will you provide Product, Component, Ingredient, and Identical Product Information?
(2 la) Enter product, and

*Q
manually on the following screens
) b) Enter product and ingredient information using separate CTP-provided sp| and enter il ion manually
() ¢) Attach product, and ingredient i using a single CTP-provided spreadsheet

(" d) Attach your own spreadsheet

‘ 0 Further instructions will appear in this section upon selection of a response to the above question

Tmport Methed for E-Liquid Products

Click on the link (Listing of Ingredients in Tobacco E-Liquid Products) to launch the pre-formatted Excel spreadsheet.

Tmport Method for Leaf-Wrapped Cigar Products:
Click on the link (Listing of Ts di

in Tobacco Leaf-Wrapped Products) to launch the pre-formatted Excel spreadsheet.
Import Methed for Ingredients in any Tobacco Product:

Click on the link (Listing of Ingredients in Any Tobacco Product) to launch the pre-formatted Excel spreadsheet

Attach the Product, Component, Ingredient spreadsheest
P = @t 3

Title |

Name Date

Oitems in the list
Path

Outline View [ﬁ
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eSubmitter X
FEMERERREERERDD

Report Type: CTP: Tebacco Product Ingredient Listing

Product Listing

I @ | = I @ J |

I s ]

Info

I

Table of Tobacco Products

> | ltem | ProductName FDA-Assigned Tracking Number STN Application #

Unique Product ID

Type of Unique Product ID Type of Unique Product ID, if Other

Product Use

Co-Package?

Product Category

1

> 2

2 0f9999 items in the list

G oo e
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BECTE AN

PEEIDIE

Submission Name: Test?
Report Type: 'CTP: Tobacco Product Ingredient Listing

Last Modified:
Date Packaged:

Select an option

> 1 would like to add another Product
# 1am finished entering Product(s) and | would like to move to the next screen

[ ignore future add/navigation messages when exiting list screens?

—
| o ]| cance

2 0f 9999 items in the list

Product Listing Q “ & J
[ @ J 2 J = J Lt | petan ] o I . | ® J
Table of Tobacco Products
= | ltem | ProduciName FDAA d Tracking Mumber STN # Unique Product ID Type of Unigue Product ID Type of Unique Product ID, If Other Product Use Co-Package? Product Category
1
> 2
List Data Message Dialeg x

s |
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eSubmitter X
Hile Edit View Table Output Tools Help
30|23 0[5/0]0 &2 e/2 08 9
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Product Listing A “ & J
[ 5 | = I @ J | List | Detail J Info J @ J J
Table of Tobacco Products
= Iltem Product Name FDA-Assigned Tracking Number STN Application # Unigue Product ID Type of Unique Product ID Type of Unique Product D, If Other Product Use Co-Package? Product Category
1
> 2

List Data Message Dialog X

Select an option

(® | would like to add another Product

("1 1am finished entering Product{s) and | would like to move to the next screen

[Z] ignore future addinavigation messages when exiting list screens?

[ oc | concer |

2 0f 9999 items in the list

. e =
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Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing
Screen View
Product Listing
[ > I = I Y ] [ List | Detail I Info ] @ ] % |
PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacco #202). L] ‘ \ |
FDA-Assigned Tracking Number (TP##t#E) TP
Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (2.g., SE1234567):
Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the product ) [ |
Selact the type of product identification number: ‘ - ‘
> ‘ If Other, please describe further: [ |
‘ Use of Product ] “ v“
IS this tobacco product a co-package? @ | Cves
) No
Product Category: [ ‘ v‘
> ‘ If Other, please describe further: [ |
Product Sub-Category: ‘ - ‘
> ‘ If Other, please describe further: [ |

ﬁ You will be prompted later ta record any produclis) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics ofthe product. You do not then need to submit separate ingredients listings for each of the products
=
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Submission Name: Test7?
Report Type: CTP: Tobacco Product Ingredient Listing

Product Listing

E)

ﬁ:a

FEIREIF

l & | = I = J{ = = J( * I

PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacca #202); L] “ |
FDA-Assigned Tracking Number (TP###F##); TP,
Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567);
Product Identification Number (At least one product identification number must be provided if needed to uniguely identify the pi List Datz Message Dialog % |
Select the type of product identification number: ‘ - |
Select an option
> ‘ If Other, please describe further:
) I would like to add another Product
| Use of Product @ 1am finished entering Product(s) and | would like to move to the next screen ® ‘ [ - ‘
[ Ignore future add/navigation messages when exiting list screens?
Is this tobacco product a co-package? ® | Oives
[T | O Mo
L] -

Product Category:

> ‘ If Other, please describe further:

Product Sub-Category.

> ‘ If Other, please describe further.

\ You will be prompted later to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product. You do not then need to submit separate ingredients listings for each of the products.

_ _ L
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Submission Name: Test7
Report Type:
=
oo [ comoonn
e
z

o il B J ® J

Product "
d |

I @ J A J

Wl
B
|
g

This screen supports the data input of tabular Component information.
For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

T e oo w0 mw
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Submission Name: Test7
CTP: Tobacco Product Ingredient Listing

Report Type:
] =
v [ oo
v
zl

P o JI @ J @ J|

Product ||
J I List J[ Detail

[ @ d = Jd @

This screen supports the data input of tabular Component information.
For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

List Data Message Dislog

Select an option

2 1 would like to add another Component

. Immﬁ= wslmlmmmmmmm“m

[~ Ignore 2

[[oc T concer |

- oo e 00

\
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[8] eSubmitter - X
File Edit View Table Output Tools Help
PR EREREIDE
Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Praduct Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all Ingredients for the product that was entered and selected In the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

L] = @ List | Detail % ™ ‘

You may enter data directly into this screen using the data entry method. As an aternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Piease note: If you already have a spreadsheet from a previous
SLUbmission, you can copy and paste your information intc the spreadsheet below.

Data Entry Method:
1. To begin, click on the "Add™ button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient. click on the "Add" button to enter information about another ingredient.
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4, After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alterate location on your computer prior to filling in the requested information. You will need to navigaie fo the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4, Once you have entered the information into the spreadsheet, click the Import Data bution on the top right corner of this screen next fo the yellow light bulb and follow the import wizard.

5. After all data is imported. you can click "List" to view and verify the imported produci(s) information

To see these instructions again, you may click on the "Info" bution above

Outline View
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Eile Edit View Table Output Tools Help
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BEPRRDIR

Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Ingredient Listing ‘
Ingredient Listing By Product ? | § |
Product
‘Component
o = G List || Detail @ ® |
How to Enter the Ingredient Information for each Product:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed o be imported here. Please note: if you aiready have a spreadsheet from a previous
submission, you can copy and paste your information info the spreadsheet below.

Data Entry Method

List Data Message Dialog x
1. To begin, click on the "Add" button to enter information on a particular ingredient.
2. Once you have entered the information about a particular Ingredient, click on the "Add" bu Select an option
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified abo
4, After you have entered all ingredients for the selected product, return to the Product Identi| ) I would like to add another Ingredient
Import Method:

ance to this screen to add the Ingredient information.

@) 1am finished entering Ingredient(s) and | would like to move to the next screen
1. You MUST select a Submission Type (the first question of this form) prior fo clicking the spi Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file fo an alternate location on your computer prior fo filling in tf ] Ignore future add/navigation messages when exiting list screens? g the import process.
3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing an
4. Once you have entered the information into the spreadsheet, click the Import Data button o

5. After all data is imported, you can click "List" to view and verify the imported produci(s) inf =

To see these instructions again, you may click on the "Info" button above.

- @
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Submission Name: Tesi7
Report Type: CTP: Tobacco Product Ingredient Listing

Last Modified:
Date Packaged:

Screen View | Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product

Product
Component

th o (Y List | Detail

How to Enter the Ingredient Information for each Product:

submission, you can copy and paste your information into the spreadsheet below.
Data Entry Method:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients

You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheet from a previous

Screen Navigation Dialog
1. To begin, click on the "Add" button to enter information on & pariicular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" bution to enter inf

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified apove. Select an option

4. After you have entered all ingredients for the selected product, return to the Product identification screen t
Import Method:

) 1 would like to add/select a new Product
1 would like to add/select a new Component

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. 7 | (& continue to the Next screen

2. Save the Excel spreadsheet file fo an alternate location on your computer prior fo filling in the requested in

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation

the List and advance to this screen to add the Ingredient information.

ite for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
of the file during the import process.

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right
5. After all data is imporied, you can click "List" to view and verify the imported produci(s}) information.

d follow the import wizard.

To see these instructions again, you may click on the “Info™ button above.

T~ @)
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B8 eSubmitter
Eile Edit View Table Ouiput Tools Help

30 B0 6/0/0)@2+ 30, 8o

Report Type: CTP: Tebacco Product Ingredient Listing

‘ zg/) Ifyou used a spreadsheet to import product and ingredient data, you may attach itto the Additional Submission Dacuments attachment question
=

Cover Letter

If you have a cover letter, please attach it here

File Attachment “ = ‘Ml i) ||

Additional Submission Documents.

Please aftach any additional documentation relevant to this submission (e.q., Import Spreadsheet template for Product Identification, chart, graph, index, table of contents, etc.).

0 items in the list

EXNEY RN EYEN Iﬁ

Title Name ‘ Date Size Path

j

4

]

Submission Comments.

Please enter any submission comments below.
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CTP Tobacco Product Manufacturer form

ERERIDR

Report Type: CTP: Tabacco Product Ingredient Listing

Screen View

Confirmation: Instructions

Last Modified:
Date Packaged:

]

The packaging process will validate that you have completed data entry.

You are now in the Confirmation section. This section contains a confirmation statement, and requests additional contact and address information, as needed. Your last step in this section is to package your submission for transmission to the Center for Tobacco Products.

Introduction > Submitter Identification > Ingredient Listing > Confirmation

e b
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PERERERRIEERERIDD

Screen View

& ‘Warming: Awillfully false statementis a criminal offense, U.S. Code, title 18, section 1001

The data and informatien in this submission have been reviewed and, to the best of my knowledge, are certified to be true and accurate. | agree to report changes to this infermation as required under section 904{c) of the act

Identify the person submitting this form: ] ||

‘ To use the eSubmitter's Address book, use the appropriate copy icons to the right

a
£

Contact Information

Prefix

First Name [ |

Middle Name: [

Last Name: [ |

Generational Suffix “7‘

Generational Suffix, if Other: [ |

Professional Suffic [ |

Position Title: [ |

Email Address: [ |

Telephone Number(s):

iil‘,ljij ii”igi‘ 0 of 4 items in the list

Telephone Number(s)

Fax Number(s)

0 of 1items in the list

Fax Number(s)

4

Mailing Address

- Outline View

——
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8] eSubmitter
File Edit View Table Output Tools Help

- x I
LlodE0jelco|s & +an 8 9
Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Confirmati Package Files for issi

-

@ You have reached the end of this submission. You may now package the submission and ransmit it to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA o provide you with an
automated acknowledgement of receipt.

Atthis ime, you may save and close this submission to return to itat a later time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu

IFyou would like to package this submissien at this time in preparation for transmitting to FDA, please begin the packaging process by selecling Output > Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are and all have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual and/or Quick Guide

If you would like to prepare another to fulfill other FDA

, please select "New” from the File Menu to begin compiling 2 new submission and be sure to select the appropriate submission type.

P e T g P ry -
- Outline View
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5l

File Edit View Table Output Tools Help
B =l A IR E

Submission Name: Test7?
CTP: Tobacco Product Ingredient Listing

@ 9

Report Type:

Last Modified:
Screen View “‘ firmati Pack Files for

Date Packaged:
@ You have reached the end of this submission. You may now package the submission and transmit itto CTP via the CTP Portal or ESG or on CD-ROM in order ta fuffill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
automated acknowledgement of receipt

Atthis time, you may save and close this submission to return to it at a later ime. To do so, simply click Save and then Close from the File Menu or top Toel Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu

If you would like to prepare another to fulfill other FDA

If you would like to package this submission at this time in preparation for transmitting to FDA, please begin the packaging process by selecting Output = Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific direclions for packaging your submission can be found in the eSubmitier User Manual and/or Quick Guide.

, please select "New” from the File Menu to begin compiling a new submission and be sure to select the appropriate submission type

[5] Warning by
() You have reached the end of the Submission form. However, the report is incomplete due to missing
* ) data. Select the Missing Data Report from the Output menu to easily identify all missing responses

T e T r - -
- Outline View
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[5] esubmitter - X
File Edit View Table Output Tools Help

= 3 R al = s
Boeanedo @ +dn @ e
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Submission Type

Submission Type

Please follow the mstructions below to select submission status properly.

Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYQ, and smokeless tobacce) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form., including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete all sections of the submission form. including Contact Information and Products and Ingredients. Only include new products. Do not include a comprehensive list of all products.

Initial submission per 904(c)(1) for modification to existing prod

Initial submission per 904(c)(2) for ification to existing p - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco additive or increases in the quantity of an existing tobacco additive.
Initial submission per 904(c)(3) for modification to existing product(s)* - Complete all sections of the submission form, incuding Contact Tnformation and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive, or adds or increases an additive.
Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and make necessary updates to the submission product information.

*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falling under 904(c)(2).
** If you are only reporting an update or correction to contact information, do not use this form. Instead, please submit a letter to FDA indicating the update or correction.

Please note: If you are discontinuing or resuming a discontimied product per 905(i)(3), you are required to submit an update to product list through 905 only and not 904_ If you are adding a product, you must submit an update to product fist per 005(i)(3) as well as submit an ingredient listing for this product under 004(c)(1).
If you are unsure how to submit your information to CTP (e.g.. corrections), please contact the help desk at eSubmitter@fda hhs gov or by telephone at 1-877-CTP-1373.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of Inpredients in Tobacco Products.

Submission Type (Please ensure that all products under this submission meet the definition of the checked submission type. Click lightbulb for definitions)

9

() Type a: Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products)
_» Type b: Initial submission per 904(c){1) for new product(s)

1 Type c: Initial ission per 904(c)(1) for modification to existing
'ype d: Initial ission per 904(c)(2) for i ion to existing
7 Type e: Initial ission per 904(c)(3) for modification to existing -

_ Type f: Amendment to correct previous product ingredient submission(s)**

> | Enter the previous product ingredient submission tracking number:

R g Ty r - .
- Qutline View
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[B] esubmitter - X

file Edit View Table Quiput Tools Help
3960060032 do 8 9

Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Role of Submitter

Statutory Requirements

The requirements under section 904(2)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required ingredient information for products they manufacture and, for tobacco products that are imported, the required ingredient information is to be submitted by either the
foreign manufacturer or the importer of the product. This includes any tobacco product, whether for consumers or for further manufacturing.

Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If you are reporting as an importer, and you are also a domestic tobacco product manufacturer, then you are also to submit the ingredient information for the
products you manufacture. In this situation, you would submit twice - once as an importer and once as a tobacco product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of i in Tobacco Products.

Please identity your role @ | ® Manufacturer

2 Importer

= >
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[5] esubmitter S

file Edit View Table Output Tools Help

IEVES [ M= e A B RN E FE N

Submission Name: Test? Last Modified:

Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Identification Information -

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Submitter Identification section. This section requests contact and address information for the responsible individual submitting the Ingredient Listing submission.

<~ @) )
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eSubmitter = ps
File Edit View Table Output Tools Hel .
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Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

To use the eSubmilter's Address book, use the appropriate copy icons to the right, m “- H| @ J

‘Company Information

Company Name. [ ]

Company Headquarters D&B D-U-N-S& Number:

[ |
[ |
Company Headquarters FDA Assigned Facility Establishment Identification (FEI) Number: \ |
\ |

Organization URL (e.g., www.fda.gov)

‘Company Mailing Address:
‘Country:

Address - Line 2;

Address - Line 1 @ |
[
[

Gity. L]

State ‘ -

State, Province, or Territory Name [ |

Zip or Postal Code:

ficial to the
Prefix
First Name/Given Name L]
Middle Name.

Generational Suffix

> | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.).

Position Title

\
[
[
Last Name: @ |
|
\
[
\
[

Email Address,

| | [ _n
u a e
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eSubmitter v3

CTP Tobacco Product Manufacturer form

GlYd B0 6/

BEEEIEICNE]

Submission Name: Tesi?
Report Type: ‘CTP: Tobacco Product Ingredient Listing

Screen View

To use the eSubmitter's Address book, use the appropriate copy icons to the right.

U.S. Agent Contact Information

Cli

Prefix | - ‘
First Name/Given Name: @ | ]
Widdle Name: [ |
Last Name: CH| |
Generational Suffic | -
> | Generational Suffix, if Other [ |
Professional Suffix (e.g., MD, Ph.D.). | \
Position Title: [ |
Email Address: | ]
Telephone Number(s)

0 of 4 items in the list
Telephone Number(s) o
’__
Fax Number: o
T 0of 1 items in the list
Fax Number(s) o
r

Mailing Address for U.S. Agent
Company Name: e | ]
Country. @ || united states |
Address - Line 1 [ |
Address - Line 2 | |

o lr
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[8] eSubmitter - x

File Edit View Table OQutput Tools Help
FERERIDR

BECTE =)

Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View . of Ingredients: Product and Ingredient Listing

Submitter Role and Submission Type > |dentification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Product and Ingredient Listing section. In this section you will enter each product and the ingredients in each product

Please note: You can import Product and Ingredient information by populating data onto the import Excel spre The import spr can be found under the Info button on the respective Product and Ingredient screens. They can be accessed by clicking the
"import Spreadsheet Tempiate" link under the Import Method section.

How will you provide Product, Component, Ingredient, and Identical Product Information? [ ] Q

(7 |a) Enter product, component, and ingredient information manually on the following screen:

) b) Enter product and ingredient information using separate CTP-provided spreadsheets, and enter component information manually
) ) Attach product, and ir lient it lion using a single CTP-provided spreadsheet

£ d) Attach your own spreadsheet

‘ 0 Further instructions will appear in this section upon selection of a response to the above question.

Import Method for E-Liquid Products:

Click on the link (Listing of in Tobaceo E-Liguid Products) to launch the ps Excel

Import Method for Leaf-Wrapped Cigar Products:
Click on the link (Listing of Ingredients in Tobacco Leaf-Wraj Products) to launch the pre-formatted Excel spreadsheet.

Tmport Method for Ingredients in any Tobacco Product:
Click on the link (Listing of Ingredients in Any Tobacco Product) to launch the pre-formatted Excel spreadsheet.

Attach the Product, Component, Ingredient spreadsheet.
PN = @« | B 0items in the list

Title | Name Date size Path

bt
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[B] esubmitter x ‘
Eile Edit View Table OQuiput Tools Helf
L[V B0 6/e/o)e2+ 2|8 9
‘Submission Name: Test? Last Modified: |
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Product Listing Q m & ]
I ) | A | @ d | st i Dea J nto I * J ¥ i
Table of Tobacco Products
|_= | hem | ProductName FDA-Assigned Tracking Number ST Application # Unique Product ID Type of Unique Product ID Type of Unique Product ID, If Other ProductUse | Co-Package? Product Category
1
2
> 3

30f9999 items in the list

Outline View s > I
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CTP Tobacco Product Manufacturer form

EE TSRO0

Submission Name: Test?

{‘3

ERYEIIC)

Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
ﬁ_ﬂ
Product Listing 9 “ $ J
I ) J 2 J = il I Deta J o I J J
Table of Tobacco Products
= Item Product Name FDA-Assigned Tracking Number STN Application # Unigue Product ID Type of Unique Product ID Type of Unigue Product D, If Other Product Use Co-Package? Product Category
1
2
> 3

List Data Message Dizlog X

Selectan option

(@ | would like to add another Product

» 1am finished entering Produci{s) and | would like to move to the next screen

|1 Ignore future add/navigation messages when exiting list screens?

3 0f 9999 items in the list

= |
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File Edit View Table Output Tools Help

EEC Tk

IR ERET

39

Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing
Screen View Listing
Product Listing
I @ | - I[ @ I [ List Info I [ @
PRODUCT IDENTIFICATION
Tebacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Recenstituted Tobacco #202): [ ] M |
FDA-Assigned Tracking Number (TP####); TP
Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (&.g., SE1234567):
Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the product ): \ \
Select the type of product identification number: ‘ - ‘
= ‘ If Other, please describe further:
| Use of Product L] “ v‘|
Is this tobacco product a co-package? @ | O ves
0 No
Praduct Category [ ] - ‘
> ‘ If Other, please describe further:
Product Sub-Category.
> ‘ If Other, please describe further:
‘ l\ You will be prompted |ater to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product You do notthen need to submit separate ingredients listings for each ofthe products

TI

G S )
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AECIEERREEEERDR

Report Type:

Submission Name: Test7

CTP: Tobacco Product Ingredient Listing

Product Listing

[ ) = a J | List 'l Detail J Info J [ @ J J
Table of Tobacco Products
= Item Product Name FDA-Assigned Tracking Number STN # Unigue Product 1D Type of Unigue Product ID Type of Unique Product ID, If Other Product Use Co-Package? Product Category
1
2
3
> 4

List Data Message Dialog

Select an option

I would like to add another Product
(@ 1 am finished entering Product(s) and | would like to move to the next screen

[~ Ignore future add/navigation messages when exiting list screens?

[ | ok || concer

4 0f 9999 items in the list

Outline View
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FECEEEOREERERIDE
] v ‘I
I @ d = J @ | List 4 Detail d o | @ d 2 P

This screen supports the data input of tabular Component information.

For help on how to use this screen, view the screen instructions avallable by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

B == oo e B
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CTP Tobacco Product Manufacturer form

X
Eile Edit View Table Qutput Tools Helr
BV =T A NI PN ST TN EY
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Praduct Ingredient Listing Date Packaged:
v
Product ‘l = ‘
[ @ J = d @ d | List J Dot J o d| @ J ® J|
This screen supports the data input of tabular Component information.
For help on how fo use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen
List Data Message Dialog X
Select an option

) I would like to add another Component
® I am fini i

to move to the next screen

["1 Ignore future add/navigation messages when exiting list screens?

e

‘Outline View _I
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CTP Tobacco Product Manufacturer form

P
G2

Submission Name: Test7

Report Type: CTP: Tobacco Product Ingredient Listing

Last Modified:
Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product

Product
Component

@ = =Y

List | Detail

How to Enter the Ingredient Information for each Product:

submission, you can copy and paste your information into the spreadsheet below.
Data Entry Methed:

Import Method:

To see these instructions again, you may click on the "Infe" button above.

L. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" bution to enter information about another ingredient.
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selecied product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

‘You may enter data directly info this screen using the data entry method. As an alternative fo daita eniry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed fo be imported here. Please note: If you already have a spreadsheet from a previous

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested information. You will need to navigate to the location of the file during the Import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.
4, Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard.
5. After all data is imported, you can click "List" to view and verify the imported product(s) information.

BT g Ty r - .
Qutline View
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Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

o = @ List | Detail ™ ™) ‘

‘You may enter data directly into this screen using the data entry method. As an alternative to data eniry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheel from a previous
submission, you can copy and paste your information into the spreadsheet below.

Data Entry Method:

1. To begin, click on the "Add" bution fo enter information on a particular ingredient.

2. Once you have entered the information about a pariicular Ingredient, click on the “"Add" button to enter information about another ingredient.

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.

Import Method:

‘You MUST select a Submission Type (ihe first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updaies) to launch the pre-formatied Excel spreadsheet.
Save the Excel spreadsheet file to an alternate location on your computer prior to filing in the requested information. You will need to navigate to the location of the file during the import process.

Mote: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard.

After all data is imported, you can click "List" to view and verify the imported product(s) information.

WL b

List Data Message Dialog X

To see these instructions again, you may click on the "Info™ button above.

Select an option

() 1 would like to add another Ingredient

‘@ | am finished entering Ingredient{s) and | would like to move to the next screen

[ ignore future addinavigation messages when exiting list screens?

Cancel

Qutline View
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Submission Name: Test?
Report Type: CTP: Tobacce Preduct Ingredient Listing

Last Modified:
Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
‘Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

%) = @ List H Detail @ &3 ‘

You may enter data direcily into this screen using the data entry method. As an alternative o data eniry, you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed to be imporied here. Piease note: If you already have a spreadsheet from a previous
submission, you can copy and paste your information into the spreadsheet below.

Data Entry Method:

Screen Navigation Dialog x
L. To begin, click on the "Add" bution to enter information on a particular ingredient
2. Once you have entered the information about a particular Ingredient, click on the "Add" button to enter inf
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above. Select an option
4. After you have entered all ingredients for the selected product, return to the Product Identification screen i ) | would like to addiselect a new Product the List and advance fo this screen fo add the Ingredient information.
Import Method: 1 1 would like to addiselect a new Component
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheetlink. 1 | @ Continue to the Next screen lte for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior o filling in the requested inf of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation
4, Once you have entered the information into the spreadsheet, click the Import Data button on the top right

m‘ d follow the import wizard.
5. After all data is imported, you can click "List" to view and verify the imported product(s) information | Lancel 4

To see these instructions again, you may click on the "Info" button above

=
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Submission Name: Test7
Report Type:

Output Tools Helf

6/0 0@z «Blale el

CTP: Tobacco Product Ingredient Listing

Last Modified:

Date Packaged:

‘ ;% If you used a spreadsheet to import product and ingredient data, you may attach it to the Additional Submission Documents attachment question
=

Cover Letter

IFyou have a cover lefter, please attach it here.

File Attachment =] ‘ Q ‘

Additional Submission Documents.

Please attach any additional relevant to this

1 (e.0., Import template for Product

, chart, graph, index, table of contents, etc.).

Name ‘

0 items inthe list
Path

|
4/

Submission Comments

L]
Please enter any submission comments below.

OMB No. 0910-0650, Expira
ﬁ Outline View

ate: 5/31/2010
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged: ‘
Screen View | Confirmation: Instructions /J|

Introduction > Submitter Identification > Ingredient Listing > Confirmation

You are now in the Confirmation section. This section contains a confirmation statement, and requests additional contact and address information. as needed. Your last step in this section is to package your submission for transmission to the Center for Tobacco Products.

The packaging process will validate that you have completed data entry.

- @)
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Submission Name: Test?

Screen View

Report Type: CTP: Tobacco Product Ingredient Listing

& ‘Waming: Awillfully false statementis a criminal offense, U.5. Code, fitle 18, section 1001

The data and information in this submission have been reviewed and, to the best of my knowledge, are cerlified to be true and accurate. | agree to report changes to this information as required under section 904(c) of the act.

Identify the persen submitting this form:

‘ To use the eSubmilter's Address book, use the appropriate copy icons to the right.

Contact Information

Prefix

First Name:

Middle Name:

Last Mame:

Generational Suffix

Generational Suffix, if Other.

Professional Suffix

Position Title

Email Address.

Telephone Number(s):

EY EYENEY EY

0 of 4 items in the list

Telephone e
Fax Number(s):
EYEYENEYEN 00 1 items in the list
Fax Number(s)

Mailing Address

“Outline View
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Confirmation: Package Files for -
You have reached the end of this submission. You may now package the submission and transmit it to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
autemated acknowledgement of receipt.
Atthis time, you may save and close this submission to return to it at a later time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submissien frem the Intro Screen or Open from the File Menu.

If you would like to package this submission at this time in preparation for fransmitting to FDA, please begin the packaging process by selecling Output = Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completad and all applicable documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual andfor Quick Guide.

If you would like to prepare another submission to fulfill ather FDA requirements, please select Mew” from the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.
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Submission Name: Test7?
Report Type: CTP: Tobacco Praduct Ingredient Listing

|

EPERIDR

Last Modified:
Date Packaged:

Screen View ‘f‘ firmati Pack Files for Sub

-

You have reached the end of this submission. You may now package the submission and transmit it to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure fransmission and enables the FDA to provide you with an
autemated acknowledgement of receipt

At this time, you may save and close this submissien to return to it at a later time. To do se, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission frem the Intro Screen or Open from the File Menu.

I you would like to package this submission at this ime in preparation for transmitting to FDA, please begin the packaging process by selecting Output > Package Files for Submission or by clicking the Package icon from the top toolbar. IFany required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual andfor Quick Guide.

If you would like to prepare another submission to fulfill other FDA requirements, please select "New” from the File Menu to begin compiling a new submission and be sure to selectthe appropriate submission type.

Warning x

() You have reached the end of the Submission form. However, the report is incomplete due to missing
data. Select the Missing Data Report from the Output menu to easily identify all missing responses.

- Qutline View
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Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

]

Screen View ‘ Listing of Ingredients: Submission Type

Submission Type

Please follow the instructions below to select submission status properly.

Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacce) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form, including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete all sections of the submission form. including Contact Information and Products and Ingredients. Only include new products. Do not include a comprehensive kist of all products.

Initial submission per 904(c)(1) for modification to existing p
Initial submission per 904(c)(2) for i ion to existing - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco additive or increases in the quantity of an existing tobacco additive.
Initial submission per 904(c)(3) for i ion to existing - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive, or adds or increases an additive.

Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and make necessary updates fo the submission product information.

*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falling under 904(c)(2).
** If you are only reporting an update or correction to contact information. do not use this form. Instead, please submit a letter to FDA indicating the update or correction.

Please note: If you are discontinuing or resuming a discontinued product per 903(i)(3). you are required to submit an update to product list through 905 only and not 904. If you are adding a product, you must submit an update to product list per 905(i)(3) as well as submit an ingredient listing for this product under 904(c)(1).
If you are unsure how to submit your information to CTP (e.g., corrections), please contact the help desk at eSubmitter@fda hhs. gov or by telephone at 1-877-CTP-1373.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of Ingredients in Tobacco Products.

Submission Type (Please ensure that all products under this submission meet the definition of the checked submission type. Click lightbulb for definitions) 1L 3]
(3 Type a: Initial per 904{a)(1) for the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products)

_» Type b: Initial submission per 904{c){1) for new product(s)

) Type c: Initial ission per 904{c){1) for i

r Type d: Initial ission per 904(c){2) for i ion isting

(@ Type e: Initial ission per 904(c){3) for modificati isti -

i Type £ [ ct previous product i jissic

* | Enterthe previous product ingredient submission tracking number;

Rt B Ty 4 . A
GEE OOy [
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Submission Name: Test7? Last Modified:
Report Type: CTP: Tobacco Preduct Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Role of Submitter ,"'J

Statutory Requirements

The requirements under section 904(a)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required ingredient information for products they manufacture and, for tobacco products that are imported, the required ingredient information is to be submitted by either the
foreign manufacturer or the importer of the product. This includes any tobacco product, whether for consumers or for further manufacturing.

Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If you are reporting as an importer, and you are also a domestic tobacco product manufacturer, then you are also to submit the ingredient information for the
products you manufacture. In this sifuation, you would submit twice - once as an importer and once as a tobacco product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of i in Tobacco Products.

Please identify your role: e ® Manufacturer
) Importer
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Identification Information -

Submitter Role and Submission Type > ldentification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Submitter Identification section. This section requests contact and address information for the responsible individual submitting the Ingredient Listing submission.

< — 1
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Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing

Screen View

To use the eSubmitter's Address book, use the appropriate copy icons to the right

‘Company Information

‘Company Name:

‘Company Headquarters D&B D-U-N-3& Number:

‘Company Headguarters FDA Assigned Facility Establishment Identification (FEI) Number

‘Organization URL (e.g., www.fda.gov).

Company Mailing Address:

Country

Address - Ling 1

Address - Ling 2

City
State

State, Province, or Territory Name

Zip or Postal Code:

to the

Prefic

First Name/Given Name:

Middle Name:

Last Name:

Generational Suffix

> | Generational Suffix, if Other.

Professional Suffix (e.g., MO, Ph.D.).

Position Title

Email Address

Telaphone Number(s)
[ | | | |

[
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m’hﬂlﬂ E‘?‘"Tobacco Product Ingredient Listing DLE'::;(T;:
Screen View

To use the eSubmitter's Address book, use the appropriate copy icons to the right.

U.S. Agent Contact Information

Prefix

First NameiGiven Name:

Middle Name:

Last Name:

Generational Suffix

> | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.):

Position Title

Email Address:

Telephone Number(s).

EYEYEFEY EX

0 of 4itemns in the list

Telephone Number(s)

Fax Number:

EYEYENEYEX

0of1itemns in the list

Fax Number(s)

Mailing Address for U.S. Agent

Company Name:

Country:

Address - Line 1:

Address - Line 2:

City:

- Outline View b > —
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View llmguf gr F and Ingredient Listing

Submitter Role and Submission Type > |dentification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Product and Ingredient Listing section. In this section you will enter each product and the ingredients in each product.

Piease note: You can import Product and Ingredient information by populating data oo the import Excel spreadsheet The Import spr
"Import Spreadsheet Template" link under the import Method section.

can be found under the (nfo button on the respective Product and ingredient screens. They can be accessed Dy clicking the

How will you provide Product, Component, Ingredient, and Identical Product Information?

v
) a) Enter product, component, and ingredient information manually on the following screen:
) b) Enter product and i

using sepal TP-provided and enter information manually
() c) Attach product, andi I

using a single CTP-provided spreadsheet
(") d) Attach your own spreadsheet

‘ o Further instructions will appear in this section upon selection of a response to the above guestion

TImport Method for E-Liquid Products:

Click on the link (Listing of Ingredients in Tobacco E-Liquid Products) to launch the pre-formatted Excel spreadsheet.

Import Method for Leaf-Wrapped Cigar Products:
Click on the link (Listing of

in Tobacco Leaf-Wrapped Products) to launch the pre-formatted Excel spreadsheet.

Import Method for Ingredients in any Tobacco Product:

Click on the link (Listing of Ingredients in Any Tobacco Product) to launch the pre-formatted Fxcel spreadsheet.

Attach the Product, Component, Ingredient spreadsheet.
WS = @ | 3

Title |

Oitems in the list
Name Date size

Outline View
|—
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Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged: |
Product Listing M m & l
l @ | 2 | = J | Lst I peta | o I > J 2 i
Table of Tobacco Products
| = | Item Product Name FDA-Assigned Tracking Number ‘STN Application # ‘Unigue Product 1D Type of Unique Product ID Type of Unigue Product D, If Other Product Use Co-Package? Product Category
1
2
3
> 4
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Submission Name: Test7?

eSubmitter v3
CTP Tobacco Product Manufacturer form

x

Report Type: CTP: Tobacco Product Ingradient Listing

Product Listing

l @ |

Last Modified:
Date Packaged:

Table of Tobacco Products

1l ]

> | ltem Product Name

FDA-Assigned Tracking Number

s ]

MEY

STN Application #

‘Unigue Product 1D

Type of Unique Product ID

Type of Unigue Product D, If Other

W

Product Use Co-Package?

Product Category

List Data Message Dialog

Select an option

(®) | would like to add another Product

[ liem imnshesientes

ild like to move to the next screen

[ Ignore future add/navigation messages when exiting list screens?

o | concat ]

4 0f 9999 items in the list

Yy

118



eSubmitter v3
CTP Tobacco Product Manufacturer form

eSubmitter - b

FEMENIERRIEERE)

Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
i _
Product Listing 9 “ & J
[ ) I - | a ] List ] Detail 'l Info ] @ ] 3 I
PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100°s or Acme Reconstituted Tobacco #202). ] “ \
FDA-Assigned Tracking Number (TP##HHHHH). TP,
If this product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567);
Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the product y [ |
Selectthe type of product identification number: | - ‘
> ‘ If Other, please describe further [ |
Use of Product: [ “ - |
I5 this tobacco product a co-package? @ | Tives
) No
Product Category: ] | - ‘
> ‘ If Other, please describe further [ |
Product Sub-Category. | zl
e ‘ If Other, please describe further. | |

‘ % You will be prompted later to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affectthe characteristics of the product. You do notthen need to submit separate ingredients listings for each of the products.

T P > 3 e
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ReportType: | CTP Tobacen ProcucingradintListing e Packagec:
Fow— vl
I @ I - I = ] [ st | Dotai I info J [ * J v J

PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacco #202): [ ] “ |
FDA-Assigned Tracking Number (TP####5#%). TP,
Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567): ,7
Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the pr List Datz Message Dialog x \ |
Select the type of product identification number: ‘ - |

Selectan option
> ‘ If Other, please describe further: ‘ ‘
1 would like to add another Product

| Use of Product @) 1am finished entering Product(s) and | would Iike to move to the next screen ° “ '”

[] Ignore future add/navigation messages when exiting list screens?

Is this tobacco product a co-package? [ ] ) Yes.
2 No
Product Category ] ‘ vl
> ‘ If Other, please describe further: [ |
Product Sub-Category: ‘ vl
> ‘ It Other, please describe further: [ |

‘ !_,/) You will be prompted Iater to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product You do notthen need to submit separate ingredients listings for each ofthe products.
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Submission Name: Test?

Report Type: CTP: Tobacco Product Ingredient Listing
=
[ [ e
?]

Product ‘l
[ @ . = J J | List | Dotai b info J | @ d ® J|

This screen supports the data input of tabular Component information_

For help on how to use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

e e oo e o
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Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacca Product Ingredient Listing Date Packaged:
| -y
snver [t oo
9]
Product " o |

[ 0 ] = J = d List ] Detal ] info J @ J ® d|

This screen supports the data input of tabular Component information.

For help on how to use this screen, view the screen insiructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

List Data Message Dialog X

Select an option

7 I would like to add another Component

Iam finished (s) and | would like to move to the next screen

T == oo sl
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘Lisiing of Ingredients: Ingredient Listing /]
Ingredient Listing By Product 9 | * |
Product
Component
) = @ List | Detail

How to Enter the Ingredient Information for each Product:

SUbmission, you can copy and paste your information into the spreadsheet beiow.
Data Entry Method:

Import Method:

To see these instructions again, you may click on the “Info™ button above.

1. To begin, click on the “Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" button to enter information about another ingredient.
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above.

4. After you have entered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry. please enter reaction products after entering all other ingredients.

You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note! If you already have a spreadsheet from a previous

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Import Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an alternate location on your computer prior to filing in the requested information. You will need to navigate to the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.
4. Once you have entered the information into the spreadsheet, click the Import Data button on the top rignt corner of this screen next to the yellow light bulb and follow the import wizard.
5. After all data is imported, you can click "List" to view and verify the imported product(s) information.

g
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Submission Name: Tesi7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Ingredient Listing /|

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

|s]

) = =Y List | Detail @ ® |

You may enter data directly into this screen using the data entry method. As an alternative fo data entry, you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed to be imporied here. Please note: If you already have a spreadsheet from a previous
submission, you can copy and pasie your information into the spreadsheet beilow.

Data Entry Methed:

List Data Message Dislog %
1. To begin, click on the "Add" button to enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" bul Seledt "
3. Repeat steps 1 and 2 until all ingredienis have been eniered for the product identified aboy elect an option
4. After you have entered all ingredients for the selected product, return to the Product Identif]

3 1 would like to add another Ingredient ance fo this screen to add the Ingredient information

Import Method: (® | am finished entering Ingredient(s) and | would like to move to the next screen
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spi Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file fo an alternate location on your computer prior to filling in tf [ Ignore future addinavigation messages when exiting list screens? g the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing an
4, Once you have entered the information into the spreadsheet, click the Import Data button
5. After all data is imported. you can click "List" to view and verify the imported product(s) infc

ort wizard

To see these instructions again, you may click on the "Infe" button above.

- @
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File Edit View Table OQuiput Tools Help
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Ingredient Listing ,‘[J

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To faciiitate data entry, please enter reaction products after entering all other ingredients.

kY

] = =Y List | Detail @ ™S ‘

‘You may enter data directly info this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheetf from a previous
submission, you can copy and paste your information into the spreadsheet below.

Data Entry Method:

Screen Navigation Dialog ®
1. To begin, click on the "Add" button to enter information on a particular ingredient.
2. Once you have entered the information about a pariicular Ingredient, click on the “"Add" button to enter inf N
3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above. Selectan option
4. After you have entered all ingredients for the selected product, return fo the Product Identification screen i 3 Iwould like o addiselect a new Product the List and advance to this screen to add the Ingredient information.
Import Method: ) 1 would like to addiselect a new Component
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. 1 | @) continue to the Next screen lie for Ingredient Identification Updates) to launch the pre-formatted Excel spreadsheet.
2. Save the Excel spreadsheet file to an aliernate location on your computer prior to filling in the requested inl of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may inferfere with importing and the validation
4. Once you have entered the information into the spreadsheet, click the Import Data bution on the top right
5. After all data is imported, you can click "List" to view and verify the imported produci(s) information.

cancel ‘ d follow the import wizard.

To see these instructions again, you may click on the "Info" button above.

Outline View
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file Edit View Table OQuiput Tools Hel
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Submission Name: Test? Last Modified:
Report Type: ‘CTP: Tobacco Product Ingredient Listing Date Packaged:
Seresn e
‘ F% Ifyou used a spreadsheet to import product and ingredient data, you may attach it to the Additional Submission Documents attachment question
=
Cover Letter

If you have a cover Ietter, please attach it here.

Fleatachment || @ | = | @ | 3y ||

Additional Submission Documents

Please attach any additional 1 relevant to this 1(e.g., Import template for Product |dentification, chart, graph, index, table of contents, etc.).
EREYEFEYEYEY items inthe list
Title | Name | Date Size | Path |
il b |
Submission Comments
Please enter any submission comments below.

Qutline View ‘ L J
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eSubmitter v3
CTP Tobacco Product Manufacturer form

89

X
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View ‘ Confirmation: Instructions )|

You are now in the Confirmation section. This section coniains a confirmation statement, and requests additional contact and address information, as needed. Your last step in this section is to package your submission for transmission to the Center for Tobacco Products.
The packaging process will validate that you have completed data entry.

Introduction > Submitter Identification > Ingredient Listing > Confirmation

-~ 33 >
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eSubmitter
Edit View Table Output Tools Hel
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Report Type: CTP: Tobacco Product Ingredient Listing

Screen View

& ‘Warmning: Awillfully false statementis a criminal offense, U.S. Code, title 18, section 1001.

The data and information in this submission have been reviewed and, to the best of my knowledge, are cerified to be true and accurate. | agree to repart changes to this information as required under section 904(c) of the act

Identify the person submitting this form:

To use the eSubmitter's Address baok, use the appropriate copy icons to the right.

Contact Information

Prefix

First Name:

Middle Name:

Last Name:

Generational Suffix

Generational Suffix, if Other:

Professional Suffix

Position Title

Email Address.

Telephone Number(s)

EYEYETEYES

0 of 4 items in the list

Telephone

Fax Number(s)

Y EYEY

0 of 1items in the list

Fax

]

[

Mailing Address

-
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[8] esubmitter
Eile Edit View Table Output Tools Help

- X
BlYE G600 @&+ B ale)e
Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View |f‘ i F ge Files for issi

-

You have reached the end of this submission. You may now package the submission and transmit it te CTP via the CTF Portal or ESG or on CD-ROM in erder to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure fransmission and enables the FDA o provide you with an
automated acknowledgement of receipt

At this time, you may save and close this submission to return to it at a latertime. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu,

If you would like to package this submission atthis time in preparation for transmitting to FDA, please begin the packaging process by selecting Qutput = Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual and/or Quick Guide.

If you would like to prepare another submission to fulfill other FDA requirements, please select "Mew” frem the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.

Qutline View
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Eile Edit View Table Output Tools Help
EVEE =l [ E

Submission Name: Test7?
Report Type: CTP: Tobacce Product Ingredient Listing

BEREEEEOE

Last Modified:
Date Packaged:

Files for Sub

Screen View ‘l‘ firmati Pach

-

o You have reached the end of this submission. You may now package the submission and transmit it to CTP via the CTP Portal or ESG or on CO-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
automated acknowledgement of receipt.

Atthis time, you may save and close this submission to return to it at a later ime. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu

If you would like to package this submission at this time in preparation for transmitting to FDA, please begin the packaging process by selecting Output = Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are and all documents have been attached within the Specific directions for packaging your submission can be found in the eSubmitter User Manual and/or Quick Guide.

If you would like to prepare another submission to fulfill other FDA requirements, please select "New" from the File Menu to begin compiling 2 new submission and be sure to select the appropriate submission type.

Warning X

" You have reached the end of the Submission form. However, the report is incomplete due to missing
( data. Selectthe Missing Data Report fram the Output menu to easily identify all missing responses

s R T g p - -
- Outline View
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file Edit View Table Ouiput Tools Help

W30 6o +a B 9l
Submission Name: Test7 Last Modified:
Report Type: CTP: Tabacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Submission Type

Submission Type

Please follow the instructions below to select status properly.

Initial submission per 904(a)(1) for product(s) on the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products) - Complete all sections of the submission form. including Contact Information and Products and Ingredients.
Initial submission per 904(c)(1) for new product(s) - Complete il sections of the submission form, including Contact Information and Products and Ingredients. Only inchude new products. Do not inchude a comprehensive list of all products.

Initial submission per 204(c)(1) for modification to existing product(s):

Initial submission per 904(c)(2) for modification to existing product(s)* - Complete all sections of the submission form, including Contact Information and Products and Ingredients. Only include products that are being modified due to a new tobacco addifive or increases in the quantity of an existing tobacco additive.
Initial submission per 904(c)(3) for modification to existing product(s)* - Complete all sections of the submission form. including Contact Information and Products and Ingredients. Only include products that are being modified due to eliminating or decreasing an existing additive. or adds or mcreases an additive.
Amendment to correct previous product ingredient submission(s)** - Perform a Save As to save the previously submitted submission with a new file name. Open the newly named file and mae necessary updates to the submission product information.

*If modification to a product involves more than one ingredient and is subject to both 904(c)(2) and 904(c)(3) reporting requirements, treat the modification to the product as falting under 904(c)(2)
** If you are only reporting an update or correction to contact information, do not use this form_ Instead, please submit a letter to FDA indicating the update or correction.

Please note: If you are discontinuing or resuming a discontinued product per 905(1)(3). you are required to submit an update to product list through 905 only and not 904. If you are adding a product, you must submit an update to product list per 905(1)(3) as well as submit an ingredient listing for this product under 904(c)(1).

If wou are unsure how to submit your information to CTP (e.g., corrections), please contact the help desk at eSubmitter@fda.hhs.gov or by telephone at 1-877-CTP-1373.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of i in Tobacco Products.

Submission Type (Please ensure that all products under this submission meetthe definition of the checked submission type. Click lightbulb for definitions) 9
) Type a: Initial ission per 904(a)(1) for the market as of June 22, 2009 (for cigarettes, cigarette tobacco, RYO, and smokeless tobacco) or August 8, 2016 (for other tobacco products)

_» Type b: Initial submission per 904{c)({1) for new product(s)

() Type c: Initial ission per 904(c)(1) for ion to existing

» Type d: Initial ission per 904(c)(2) for i ion i isting

) Type e: Initial ission per 904{c)(3) for ion to existing -

@ype f: Amendment to correct previous product ingredient submission(s)**

4 ‘ Enter the previous product ingredient submission tracking numboer: L] | m

S & 5 =
_ Outline View
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W30 6 Qo2 «/so

Submission Name: Test7 Last Modified:
Report Type: CTP: Tabacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Role of Submitter

Statutory Requirements

The requirements under section 904(2)(1) of the act apply to each tobacco product manufacturer or importer. Domestic manufacturers are to submit the required ingredient information for products they manufacture and, for tobacco products that are imported. the required ingredient information is to be submitted by either the
foreign mamufacturer or the importer of the product. This includes any tobacco product, whether for consumers or for further manufacturing.

Other provisions of the Tobacco Control Act pertinent to Ingredient Listing include Section 904(c) of the act.

Please note: For tobacco products that are imported, the required ingredient information is to be submitted by either the foreign manufacturer or the importer of the product. If you are reporting as an importer. and you are also a domestic tobacco product manufacturer, then you are also to submit the ingredient information for the
products you manufacture. In this situation, you would submit twice - once as an importer and once as a tobacco product manufacturer.

For information regarding the section 904 requirements, please refer to the Guidance: Listing of i in Tobacco Products.

Please identify your role @Y | @ Manufacturer

) Importer

=

132



eSubmitter v3
CTP Tobacco Product Manufacturer form
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File Edit View Table OQuiput Tools Help

390 305 0|0l «/aee

Submission Name: Test? Last Modified:

Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View ‘ Listing of Ingredients: Identification Information ,J

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation
You are in the Submitter Identification section. This section requests contact and address information for the responsible individual submitting the Ingredient Listing submission.

T L
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Submission Name: Test?
Report Type: CTP: Tobacco Product Ingredient Listing

Screen View

To use the eSubmitters Address book, use the appropriate copy icons to the right.

‘Company Information

Company Name:

Company Headquarters D&B D-U-N-S® Number:

Company Headquarters FDA Assigned Facility Establishment Identification (FEI) Mumber:

Organization URL (e.g., www.fda gov)

‘Company Mailing Address:

Country:

Address - Line 1:

Address - Line 2:

ity

‘State:

‘State, Province, or Territory Name

Zip or Postal Code:

ial i to the submitter)

Prefix:

First Name/Given Name:

Middle Name:

Last Name:

Generational Suffix:

* | Generational Suffix, if Other.

Professional Suffix (e.g., MD, Ph.D.).

Position Title:

Email Address:

Telephone Number(s):
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File Edit View T, Qutput Tools Helf
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Submission Name: Test?
Report Type: CTP: Tobacco Product Ingredient Listing

To use the eSubmitter's Address book, use the appropriate copy icons to the right.

U.S. Agent Contact Information

Prefix

First Name/Given Name L]

Middle Name:

Last Name: L]

> | Generational Suffix, if Other.

Professional Suffix (e.g, MD, Ph D).

Position Title:

[
\
[
Generational Suffix ‘ vI
[
\
[
Email Address: [

Telephone Number(s):

MEEJ‘: |;?J! 2 J 0 of 4 items in the list

Telephone Number(s)

Fax Number:
MEEJ‘: |;?J! 3 J 0 of 1items in the list
FaxNumber(s)
Mailing Address for U.S. Agent
Company Name: @ ‘ |
Country: @ [ united States M
Address - Line 1: @ | |

Address - Line 2: [ |

Ci @ | E]
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Submission Name: Test7 Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Listing of Ingredients: Product and Ingredient Listing | 2}

Submitter Role and Submission Type > Identification Information > Product and Ingredient Listing > Additional Information > Confirmation

You are in the Product and Ingredient Listing section. In this section you will enter each product and the ingredients in each product.

Please note: You can import Product and Ingredient information by populating data onto the import Excel spr The import spi can be found under the Info button on the respective Product and ingredient screens. They can be accessed by clicking the
"import Spreadsheet Tempiate" link under the Import Method section.

How will you provide Product, Component, Ingredient, and Identical Product Information? *Q

& lg) Enter product, component, and ingredient information manually on the following screen§|

() b) Enter product and i ion using sepal TP-provided spl and enter i ion manually

) c) Attach product, andi i ion using a single CTP-provided spreadsheet
( d) Attach your own spreadsheet

‘ 0 Further instructions will appear in this section upon selection of a response to the above question

Import Method for E-Liquid Products:

Click on the link (Listing of Ingredients in Tobacco E-Liquid Products) to launch the pre-formatted Excel spreadsheet.

Tmport Method for Leaf-Wrapped Cigar Products:

Click on the link (Listing of Ingredients in Tobacco Leaf-Wrapped Products) to launch the pre-formatted Excel spreadshest.

Import Method for Ingredients in any Tobacco Product:
Click on the link (Listing of ients in Anv Tobacco Product) to launch the pre-formatted Excel spreadsheet.

Attach the Product, Component, Ingredient spreadshast

2SS =@ @t 3 0 items in the list
Title | Name Date Size Path

Outline View
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File Edit View Table Output Tools Help

B == AR RS EIENNCY

—><|

‘Submission Name: Test7

Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
i i
Product Listing [} m & I
I & J = J @ d | ust l vetan J o J > d © J
Table of Tobacco Products
> | item | Product Name FDA-Assigned Tracking Number STN # Unique Product ID Type of Unique Product ID Type of Unique Product I, If Other ProductUse | Co-Package? Product Category.

1

2

3

4
L 5

5 0f 9999 items in the list
_—

I

a Outline View
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AEEEEEPEHEERERIDE
Product Listing Q “ & J
l ) | = | = d | List | Detail | iafo J J d

FDA-Assigned Tracking Number STN Application #

Unigue Product ID Type of Unique Product ID

Type of Unique Product ID, If Other

Product Use Co-Package?

o e

List Data Message Dialog

Select an option

# | would like to add another Product
1 am fini: ing Pr

to move to the next screen

[~ Ignore future add/navigation messages when exiting list screens?

5 0f9999 items in the list

G oD oD
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eSubmitter - B X

Bldu aDjsle o sl2walaele

Submission Name: Test7
Report Type: CTP: Tobacco Product Ingredient Listing
Screen View il
Product Listing
I ) | = ]I @ ] I List ” Detail JI Info ] [ @
PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacco #202) "] “ |
FDA-Assigned Tracking Number (TP#ats##). TP
Ifthis product is under review or has been authorized under a marketing pathway, enter the submission tracking number of the application (e.g., SE1234567).
Product Identification Number (At least one product identification number must be provided if needed to uniquely identify the product ) ‘ |
Select the type of product identification number. ‘ - |
> | If Other, please describe further: [ |
‘ Use of Product L] “ vl‘
Is this tobacco product a co-package? @ | Oives
2 No
Product Category ] ‘ - |
> | If Other, please describe further: [ |
Product Sub-Category: ‘ - |
=4 | IFOther, please describe further: ‘ ‘

g) You will be prompted later to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product. You do notthen need to submit separate ingredients listings for each of the products.

N R > 1 s
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Submitter - x

file Edit View Table Output Tools Help

PECIEEERERIEEERE IR
Submission Name: Test? Last Modified:
Report Type: CTP: Tebacco Product Ingredient Listing Date Packaged:

Product Listing

| & [ - ]I = I = I . | >
PRODUCT IDENTIFICATION
Tobacco Product Brand/Sub-brand Name or Other Commercial Name (e.g., Acme Lights 100's or Acme Reconstituted Tobacco #202): ] || |
FDA-Assigned Tracking Number (TP#######2): TP
Ifthis product is under review or has been authorized under a marketing pathway, enter the submission fracking number of the application (e.g., SE1234567).
Product Identification Number (At least one product identification number must be provided if needed to uniguely identify the pi List Data Message Dialog X | |
Selectthe type of product identification numboer: | - |

Selectan option

> ‘ If Other, please describe further.

) I would like to add another Product

| Use of Product: @® 1 am finished entering Product{s) and | would like to move to the next screen ° || - ”
[_] Ignore future add/navigation messages when exiting list screens?
Is this tobacco product a co-package? @ | Oves
2 No
Product Categary: [ ] - |

= ‘ If Other, please describe further.

Product Sub-Category:

> ‘ If Other, please describe further:

‘ '.-\ You will be prompted later to record any product(s) that you manufacture that are identical to the product above other than packaging differences that do not affect the characteristics of the product. You do not then need to submit separate ingredients listings for each of the products.
=
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FECEEEOREERERIDE
] v ‘I
I @ d = J @ | List 4 Detail d o | @ d 2 P

This screen supports the data input of tabular Component information.

For help on how to use this screen, view the screen instructions avallable by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

B - o e B
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File Edit View Table Output Tools

Elod Blme/olol| 8@ /3

‘Submission Name: Test?
Report Type:

NN

‘CTP: Tobacco Product Ingredient Listing

Product |

[ @ J = J 2 J |

List | Detail F|

This screen supports the data input of tabular Component information.

Info

For help on how 1o use this screen, view the screen instructions available by selecting the 'Hint' option (denoted by a lightbulb) at the top right of the screen.

List Data Message Dialog

‘Select an option

2 I would like to add another Component
-

entering C

[ ignore future addinavigation messages when exiting list screens?

G oD e
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eSubmitter

- X
File Edit View Table Output Tools Help
E I M= e A BT E IR ET =Y

Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:

Screen View | Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product
Product
Component

How to Enter the Ingredient Information for each Product:
List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate daia eniry, please enter reaction products after entering all other ingredienis.

@ = @ List | Detail @ ™S ‘

You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this information into a pre-formatied spreadsheet that CTP has specifically designed to be imporied here. Please note: If you alveady have a spreadsheel from a previcus
submission, you can copy and paste your information into the spreadsheet below.

Data Entry Method:

1. To begin, click on the "Add" bution fo enier information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" bution to enter information about another ingredient.

3. Repeat steps 1 and 2 until all ingredients have been entered for the product identified above

4. After you have eniered all ingredients for the selected product, return to the Product Identification screen to enter another product. Select the next product in the List and advance to this screen to add the Ingredient information.
Import Method:

1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. Then, click on the link (Impori Spreadsheet Template for Ingredient Identification Updates) to launch the pre-formatied Excel spreadsheet.
1. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested information. You will need to navigate to the location of the file during the import process.

3. Note: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the data.

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner of this screen next to the yellow light bulb and follow the import wizard.

5. After all data is imported, you can click "LIst" to view and verify the imported product(s) information.

To see these instructions again, you may click on the “"Info™ button above.
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file Edit View Table OQuiput Tools Help
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Submission Name: Test7 Last Modified:
Report Type: CTP: Tabacco Product Ingredient Listing Date Packaged:

Screen View ‘ Listing of Ingredients: Ingredient Listing

Ingredient Listing By Product

Product
‘Component

[+ = @

List ” Detail

How to Enter the Ingredient Information for each Product:

submission, you can copy and paste your information into the spreadsheet below.

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data eniry, please enter reaction products after entering all other ingredients.

‘You may enter data directly into this screen using the data eniry method. As an alternative to data entry, you may enter this information info a pre-formatied spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheel from a previous

Data Entry Method:

List Data Message Dislog

1. To begin, click on the "Add" bution fo enier information on a particular ingredient.

2. Once you have entered the information about a pariicular Ingredient, click on the "Add" bu|
3. Repeat sieps 1 and 2 until all ingredienis have been entered for the product identified aboy
4. After you have entered all ingredients for the selected product, return to the Product Identi

Import Method

You MUST select a Submission Type (the first question of this form) prior to clicking the spi
Save the Excel spreadsheet file to an alternate location on your computer prior to filling in i

Select an option

> I would like to add another Ingredient

® | am finished entering Ingredient(s) and | would like to move to the next screen

[T] Ignere future addinavigation messages when exiting list screens?

ance to this screen to add the Ingredient information.

Identification Updates) to launch the pre-formatted Excel spreadsheet
g the import process.

Note: Avoid changing the format of the spreadsheet as this may interfere with importing an
Once you have entered the information into the spreadsheet, click the Import Data bution o
After all data is imporied. you can click "List™ to view and verify the imported product(s) inft

U ST

Cancel

jort wizard

To see these instructions again, you may click on the "Info" button above.

G COD e
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Submission Name: Test? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View |Li:fngoflngne1iems: Ingredient Listing ‘
Ingredient Listing By Product

e
Product
Component

@ - @

List | Detail

How to Enter the Ingredient Information for each Product:

List all ingredients for the product that was entered and selected in the previous screen (displayed in the "Product” header above). To facilitate data entry, please enter reaction products after entering all other ingredients.

‘You may enter data directly into this screen using the data entry method. As an alternative to data entry. you may enter this information info a pre-formatted spreadsheet that CTP has specifically designed to be imported here. Please note: If you already have a spreadsheet from a previous
submission, you can copy and paste your information inio the spreadsheet below.
Data Entry Methed:

. i . Screen Navigation Dizlog x

1. To begin, click on the "Add" button fo enter information on a particular ingredient.

2. Once you have entered the information about a particular Ingredient, click on the "Add" button to enter infi

3. Repeat sieps 1 and 2 until all ingredients have been entered for the product identified above. alectananion

4, After you have entered all ingredients for the selected product, return to the Product Identification screen e © Iwoukl Bike fo add/select a new Product the List and advance to this screen to add the Ingredient information.
Import Method:

1 would like to add/select a new Component
1. You MUST select a Submission Type (the first question of this form) prior to clicking the spreadsheet link. 1

@ Continue to the Next screen lte for Ingredient |dentification Updates) to launch the pre-formatted Excel spreadsheet.
2 Save the Excel spreadsheet file to an alternate location on your computer prior to filing in the requested ini of the file during the import process.

3. Note: Avoid changing the format of the spreadsneet as this may interfere with importing and the validation

4. Once you have entered the information into the spreadsheet, click the Import Data button on the top right
5. After all data is imported, you can click "List" to view and verify the imported product(s) information.

‘ d follow the import wizard.

To see these instructions again, you may click on the "Info" button above.

e VI
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[B] esubmitter
File Edit View Table

PEEIERIEE

Submission Name: Test7?

eSubmitter v3

CTP Tobacco Product Manufacturer form

AR EREEIDIR

Report Type: CTP: Tobacco Product Ingredient Listing

Last Modified:
Date Packaged:
tﬂ) If you used a spreadsheet to import product and ingredient data, you may attach it to the Additional Submission Documents attachment question
=
Cover Letter

If you have a cover lefter, please attach it here.

Fieatachment [ @ | = | @ | 3 “

Additional Submission Documents

Please attach any additional 1 relevant to this (e.g., Import template for Product |dentification, chart, graph, index, table of contents, etc.).
EYEVEYIEYEY otems it st
Title | Name | Date size | Path |
il [»]
Submission Comments
Please enter any submission comments below.

Qutline View
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CTP Tobacco Product Manufacturer form

5] esubmitter
File Edit View Table Output Tools Help
Blod/pDieloo sl v a3 8,9l

- X |
Report Type: CTP: Tobacco Product Ingredient Listing

Screen View ‘ Confirmation: Instructions

Last Modified:
Date Packaged:

-

Introduction > Submitter Identification > Ingredient Listing > Confirmation

You are now in the Confirmation section. This Section contains a confirmation statement. and requests additional contact and address information. as needed. Your last step in this section is to package your submission for transmission to the Center for Tobacco Products.
The packaging process will validate that you have completed data entry.

" Outline View
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eSubmitter v3
CTP Tobacco Product Manufacturer form

PENERFERIEERERDE

Screen View

& ‘Warning: Awillfully false statement is a criminal offense, U.S. Code, title 18, section 1001

The data and information in this submission have been reviewed and, to the best of my knowledge, are certified to be true and accurate. | agree to report changes to this information as required under section 904(c) of the act

Identify the person submitting this form: [ ] “

‘ To use the eSubmitters Address book, use the appropriate copy icens to the right “

g
€

Contact Information

Prefix.

First Name:

Middle Name:

Last Name:

Generational Suffix ‘ 1

Generational Suffix, if Other. \ \

Professional Suffix [ |

Position Title [ |

Email Address [ |

Telephone Number(s).

IEH_E_JLJ i_ﬁ__ﬂl‘ 0 of 4items inthe list

Telephone Number(s)

Fax Number(s):

Ilhiiﬂil iz”i‘sﬁ ‘ 00f 1 items inthe list

Mailing Address

- Qutline View
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CTP Tobacco Product Manufacturer form

[8] eSubmitter - b4

File Edit View Table Output Tools Help

oW onealco ¢l ez n @ e

Submission Name: Tesi? Last Modified:
Report Type: CTP: Tobacco Product Ingredient Listing Date Packaged:
Screen View | Confi i Package Files for

L4

You have reached the end of this submission. You may now package the submission and transmit it to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
automated acknowledgement of receipt.

Atthis time, you may save and close this submission to return to it at a later time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu.

If you would like to package this submission at this time in preparation for transmitting to FDA, please begin the packaging process by selecting Output > Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual and/or Quick Guide

Ifyou would like to prepare another submission to fulfll other FDA requirements, please select "Mew” fram the File Menu to begin compiling a new submission and be sure to select the appropriate submission type

e >
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eSubmitter v3
CTP Tobacco Product Manufacturer form

file Edit View Table Output Tools Help

Slulg

el

FRIE

W

Submission Name: Test7
Report Type:

Screen View ‘ C

EEETIIE)

CTP: Tobacce Product Ingredient Listing

ge Files for

automated acknowledgement of receipt.

Last Modified:

If you would like to package this at this time in

-

Date Packaged:
You have reached the end of this submission. You may now package the submission and transmit it to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an

At this time, you may save and close this submission to return to it at a Iater time. To do so, simply click Save and then Close from the File Menu or top Tool Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu.
ion for

to FDA, please begin the packaging process by selecting Output > Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are completed and all applicable documents have been attached within the submission. Specific direclions for packaging your submission can be found in the eSubmitter User Manual andior Quick Guide.
If you would like to prepare another submission to fulfill ather FDA requirements, please select "New” fram the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.

Warning

"
A

You have reached the end of the Submission form. However, the report is incomplete due to missing
data. Selectthe Missing Data Report from the Output men to easily identify all missing responses.

BT e T g - »
_ Outline View
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